Contents
About this guide.................................................................................................................................... 10
Audience................................................................................................................................................ 10

1
3132 Driver Installation......................................................................................................................... 11

2
Introducing the SiI 4726 Storage Appliance........................................................................................ 11
Product overview .................................................................................................................................. 11
How the SiI 4726 Storage Appliance operates................................................................................... 12
SiI 4726 storage policies...................................................................................................................... 12

3
Installing the SiI 4726 Storage Appliance........................................................................................... 13
Prerequisites......................................................................................................................................... 13
Hardware................................................................................................................................................ 13
Software................................................................................................................................................. 14
Install the SiI 4726 hardware................................................................................................................ 14
Install the SV-HBA3124 card and driver.............................................................................................. 14
Connect the host to the SiI 4726 Storage Appliance......................................................................... 14
  MS Windows...................................................................................................................................... 14
  Mac OS X........................................................................................................................................... 15

4 SATARAID5™ Management Software (For Windows Only)
SATARAID5 Features............................................................................................................................ 16
Data Security.......................................................................................................................................... 16
Data Performance................................................................................................................................. 18
Data Versatility...................................................................................................................................... 18
Ease of Use............................................................................................................................................ 18
5
Getting Started ..................................................................................................................................... 20
Start the SiI 4726 Manager .................................................................................................................. 20
Start the SiI 4726 Manager ................................................................................................................... 20
MS Windows...................................................................................................................................... 20
Mac OS X........................................................................................................................................... 20
A Look at the SiI 4726 Status Window................................................................................................ 20

6
Basic Configuration.............................................................................................................................. 21
A Look at the Basic Configuration Wizard ........................................................................................ 21
Configure Volumes .............................................................................................................................. 22

7
Advanced Configuration ..................................................................................................................... 23
Why Advanced Configuration? .......................................................................................................... 23
A Look at the Advanced Configuration Wizard ................................................................................. 24
Configure Multiple Volumes ................................................................................................................ 27
Manage Configuration Files ................................................................................................................ 27
  Import a configuration file ............................................................................................................. 27
  Save a configuration file ................................................................................................................ 28

8
Partitioning Configured Volumes ........................................................................................................ 28
Partition a Volume ................................................................................................................................. 28
  MS Windows ....................................................................................................................................... 28
  Mac OS X .......................................................................................................................................... 29

9
Administering the SiI 4726 ................................................................................................................. 29
Change Password ............................................................................................................................... 29
Manage Client Connection to the Daemon ........................................................................................ 30
  Prerequisites .................................................................................................................................... 30
About this guide

This guide describes how to configure the Sil 4726 Storage Appliance for the optimum allocation of available disk storage space for your applications.

Note: The Sil 4726 Manager User’s Guide presents screens captured in MS Windows. If a dialog appears differently on the Macintosh vs. MS Windows operating systems, the Mac OS X images are presented in addition to the MS Windows images.

Audience

This guide provides the information needed to pre-configure the Sil 4726 for the end-user so that it can be sold as a ready-to-use storage device. Experienced end-users may configure the Sil 4726 Storage Appliance on an exception basis.
1 Begin with 3132 Driver Installation

Please install 3132 Driver before continue

2 Introducing the Sil 4726 Storage Appliance

This chapter introduces the Sil 4726 Storage Appliance through a product overview, a description of system-level function, and definition of the Sil 4726 storage policies.

Product overview

The **Sil 4726 Storage Appliance** is powered by Silicon Image's industry-leading Serial Advanced Technology Attachment (SATA). SATA is an interface between desktop computers/servers and attached hard disk drives. SATA supersedes the Parallel Ultra ATA/100 interface, improving performance from 100 MB/sec to a data transfer rate of 150 MB/sec with SATA Generation 1 (gen1) and 300 MB/sec with SATA Gen2. Populated with five SATA drives, the Sil 4726 Storage Appliance stores as much as 2.5 terabytes of data.

The Sil 4726 Storage Appliance is coupled with a processing architecture that provides enhanced data protection, high-performance storage, and plug-and-play functionality. The Sil 4726 Storage Appliance is a simple and affordable solution that transparently replicates data, eliminating a vulnerability that is too often overlooked or considered too expensive to solve. Volumes can be created with mirrored drives, providing automated data protection along with notifications when a drive needs replacement.

The Sil 4726 Storage Appliance is available from leading storage partners in preconfigured user set-ups or it can be set up on site. The end-user does not need to be an experienced storage network administrator to understand and configure the Sil 4726 Storage Appliance, nor does he need prior knowledge of physical disk drives or storage concepts. The Sil 4726 Manager can be run at any time to monitor or reconfigure the Storage Appliance. The Sil 4726 Manager's monitoring function allows preventive maintenance and enables troubleshooting by using environment-control feedback. The guided configuration utility helps the end-user set up and maintain the best possible configuration for his/her organization.

For demanding performance applications such as video or audio editing, digital imaging, sophisticated data manipulation, or just the fastest gaming platform in town, the Sil 4726 Storage Appliance can be preconfigured as a striped disk array, simultaneously accessing multiple drives for blazing fast disk performance.

The industry-approved external SATA connector assures a robust and reliable interconnect and extends the reach of your Sil 4726 Storage Appliance.
How the SiI 4726 Storage Appliance operates

The SiI 4726 architecture (Figure 1) supports configuration and management of multiple storage devices connected to a single host. Its built-in features include RAID configuration, disk rebuild, and virtualization capabilities. Disk virtualization uses the SiI 4726’s innovative SteelVine processor technology to map the physical drives to virtual drives for optimal storage.

In its basic form, the SiI 4726 Storage Appliance supports individual mapping of a hard disk drive to a corresponding volume or virtual drive.

Using complex mapping options, the physical drives can be concatenated and mapped to virtual drives in several ways to implement FAST, SAFE, or BIG storage policies, as described in the next section. Depending on the end-user’s choice, the data is written to one or more disks sequentially or simultaneously.

The SiI 4726 Manager User’s Guide assumes that end-users are using the SV-HBA3124-4 host bus adapter and driver, which provide port multiplier support as a SATA host. Refer to "Install the SiI 4726 hardware" for more information on running the SiI 4726 Storage Appliance with other hosts that may not support port multipliers.
Sil 4726 storage policies

The following terms represent Sil 4726 configuration options, or storage policies, for mapping physical to virtual drives. The end-user can choose from these policies when s/he configures the volumes (virtual drives) using the Basic Configuration Wizard or the Advanced Configuration Wizard.

**JBOD**
A storage policy that grants the host computer direct access to a physical disk drive. With JBOD (*just a bunch of disks*), the number of available virtual drives is equal to the number of physical drives. JBOD is also called the bypass mode because the host bypasses the SteelVine virtualization engine to access the drive directly.

**SAFE**
A storage policy in which all data are stored in duplicate on separate hard disk drives to protect against data loss due to drive failure. At least two hard disk drives mirror each other at all times, equivalent to RAID 1. Every write operation goes to both drives. SAFE provides the highest level of data protection, but halves the amount of storage space because all data must be stored twice.

To implement the SAFE storage policy, the Basic Configuration Wizard creates two volumes. Each volume consists of two hard disk drives that mirror each other. The remaining hard disk drive is specified as a Hot Spare for both volumes.

**BIG**
A storage policy configuration in which multiple physical hard disk drives are concatenated and treated as one large volume. This configuration allows the end-user to increase logical volume size beyond the capacity of individual hard disk drives. BIG provides the maximum amount of storage space, but no additional performance or data redundancy.

The Basic Configuration Wizard implements the BIG storage policy by concatenating all the hard disk drives into a single volume.

**FAST**
A storage policy in which I/O processing is balanced evenly in a method known as striping, equivalent to RAID 0. Striping increases storage operation speed as each portion of data is divided into segments that are written to different disks simultaneously. FAST offers the best performance in terms of speed, but has no redundancy of data.

To implement the FAST storage policy, the Basic Configuration Wizard creates a single volume of up to five hard disk drives in a striped format.

**SAFE and BIG**
A storage policy in which one-half of the available storage space is concatenated. The other half mirrors the first half to provide full data redundancy.

To implement the SAFE and BIG storage policy, the Basic Configuration Wizard creates a volume consisting of four hard disk drives and designates the remaining drive as a Hot Spare.

**SAFE and FAST**
A storage policy in which an array of stripes is created. Each stripe consists of two mirrored drives. SAFE and FAST provides the I/O load balancing features of striping and the added reliability of mirrored data, equivalent to RAID 1+0. Data are written to mirrored disks in a striped format.

To implement the SAFE and FAST storage policy, the Basic Configuration Wizard creates a virtual drive consisting of four hard disk drives and designates the remaining drive as a Hot Spare.
Hot Spare
One or more hard disk drives are unused during normal operation and are configured to be a spare. If an active drive in a SAFE volume fails, the data on the remaining hard disk drive is duplicated onto the Hot Spare to regain redundancy. All SAFE volumes can have a designated Hot Spare (SAFE, SAFE and FAST, and SAFE and BIG).

Volume
A virtual drive comprised of one or more physical hard disk drives. Once the end-user creates a volume, the operating system uses and maintains the volume as if it were a single hard disk drive. This allows software to overcome size restrictions imposed by physical disk drives.

Daemon
Component of the SiI 4726 Manager responsible for status tracking and SAFE volume rebuilds. See "Manager Client Connection to the Daemon" for further details regarding the daemon.

3 Installing the Sil 4726 Storage Appliance

This chapter describes how to install the Sil 4726 Storage Appliance and Sil 4726 Manager software.

Prerequisites

The Sil 4726 installation has the following hardware and software prerequisites for the host computer(s) that will be connected to the Sil 4726 Storage Appliances.

Hardware

- *For x86 platforms:* An Intel PIII 500MHz equivalent or faster
- *For Mac platforms:* A Mac G4 500MHz or faster
- CD-ROM drive
- 64 MB of RAM minimum
- 250 MB of free hard disk space
- Super VGA (800 x 600) or higher resolution with 256 colors
- Mouse or compatible pointing device
- External SATA cable connection between the Sil 4726 Storage Appliance and the host computer
Software

- *For Mac platforms:* Mac OS X with the latest set of patches installed.
- SV-HBA3124 CD

Install the Sil 4726 hardware

In order to run the Sil 4726 Manager, first install the Silicon Image SV-HBA3124 host controller (card and driver) or another SATA host controller with port multiplier (PM) support. The host controller provides a software and hardware link between the host computer and the Sil 4726 Storage Appliance.

The SV-HBA3124 board uses the Sil3124-2 SATA II controller with port multiplier support. You can use the Sil 4726 Storage Appliance with any SATA host controller with port multiplier support. In addition to the SV-HBA3124 host card, the following Silicon Image controllers provide port multiplier support:
  - Sil3124-2
  - Sil3124-4
  - Sil3132

Install the SV-HBA3124 card and driver

1. Turn off the host computer.
2. Install the SV-HBA3124 card into a PCI-X or PCI slot. Refer to the [SV-HBA3124 Quick Installation Guide](#) included on your SV-HBA3124 CD for details.
3. Insert the CD into the CD-ROM drive.
4. Click the **SV3124 Setup** icon in the Windows or Mac directory and follow the Installation Wizard to complete the installation. Refer to the [SV-HBA3124 User’s Guide](#) for details.
5. Check [www.steelvine.com](http://www.steelvine.com) for updated software and manuals. Upgrade the driver software if needed.

Connect the host to the Sil 4726 Storage Appliance

The Sil 4726 Storage Appliance houses five configurable hard disk drives. After installing the SV-HBA3124 card and drivers, connect the host computer to the Sil 4726 Storage Appliance. Take a moment to verify that the host computer sees the Sil 4726 hard disk drives.

MS Windows

1. Plug the Sil 4726 Storage Appliance into an AC power outlet and turn the Sil 4726 power switch to ON.
2. Attach the Sil 4726 Storage Appliance to the SV-HBA3124 on the host computer with an external SATA cable.
3. Right-click the **My Computer** icon on your desktop and select **Manage** from the pop-up menu.
4. Click **Disk Management** under **Storage** to view the disk drives.

5. If an **Initialize and Convert Disk Wizard** dialog appears, click **Cancel** to close the Wizard and proceed to **Disk Management**.

6. Verify that all five drives are visible in their preconfigured and unallocated state. If the host does not see the Sil 4726 hard disk drives, refer to the Troubleshooting section for corrective actions.

   The Status window provides details of the volume allocation. A sixth disk appears without capacity in the list to represent the SteelVine processor. **Do not initialize or partition this SteelVine disk.**

---

**Mac OS X**

1. Plug the Sil 4726 Storage Appliance into an AC power outlet and turn the Sil 4726 power switch to ON.

2. Attach the Sil 4726 Storage Appliance to the SV-HBA3124 with an external SATA cable.

3. A warning appears. Because the Sil 4726 ships with empty drives, Mac OS X does not identify a recognizable file system. Click **Ignore** as many times as needed to dismiss the message boxes.

   __Note: This warning will show up every time you reboot the Mac system. This pop-up warning will be displayed for the config drive. Ignore this as functionally it has no impact.__
4. Launch **Disk Utility** from the **Application > Utilities** folder to view the disk drives.

5. Verify that all five drives are visible in their pre-configured and unallocated state. If the host does not recognize the SiI 4726 hard disk drives, refer to the Troubleshooting section for corrective actions.

A “320.0 KB Config Disk Media” disk appears in the list of hard disk drives to represent the SteelVine processor. **Do not initialize or partition the “320.0 KB Config Disk Media” disk.**
Note: Do not initialize or partition the “320.0 KB Config Disk Media” drive.
Mac OS X recognizes five 152.7 GB hard disk drives for an Sil 4726 Storage Appliance in
JBOD (bypass mode) populated with five 160GB hard disk drives.

The Sil 4726 Manager searches for an active daemon and launches a daemon process if the
daemon is not active. This application also launches the Sil 4726 Manager to display the
information captured by the daemon.

The daemon launch script is also added to the Library/StartupItems/Sil 4726Daemon
directory to launch the daemon every time Mac OS is started.

Note: The daemon has “root user” privileges.

Check www.steelvine.com for updated software and manuals. Install a new version of the Sil 4726
Manager if needed. See the “Quick Install Guide” for details.

(If you are using Windows operating system, please skip Sil 4726 and move on to SATARAID 5)
4 SATARAID5™ Management Software (For Windows Only)

SATARAID5 Features

Data Security

SATARAID5 provides our highest commitment to data security through the use of RAID architecture to back up and protect data. RAID levels 1, 5, and 10 provide data security. SATARAID5 supports sophisticated sparing support so that hardware failure risk can be minimized by automatically regenerating the failed disk's data on a backup disk. The software driver includes support for Self-Monitoring Analysis and Reporting Technology ("S.M.A.R.T.") to predict disk failures. Drives can be moved between controllers without losing data.

Data Performance

SATARAID5 can increase storage throughput by combining the throughput of multiple drives into a single volume. RAID levels 0, 5, and 10 support this ability.

Data Versatility

The driver supports Just a Bunch of Disks (JBOD) and Concatenated drives for applications that do not require increased security or performance. The JBOD state may also be achieved with the driver's "Pass-Thru" feature. "Pass-Thru" allows access to a new hard disk or one without any SATARAID5 configuration.

Ease of Use

The SATARAID5 Manager GUI offers an easy-to-use utility to create and manage your storage. Creating and deleting volumes is possible without requiring a restart of the operating system. Rebuilds never require the data to be taken off-line.

Note: A known problem with some versions of Microsoft Windows may cause an unnecessary Parity Rebuild operation following hibernation. To address this issue, please apply the patch available from Microsoft at http://support.microsoft.com/?kbid=902853
This chapter explains how to start the SiI 4726 Manager and describes the Status window.

Start the SiI 4726 Manager

The SiI 4726 Manager starts with the Status window visible so the end-user can monitor the SiI 4726 Storage Appliances connected to the host computer. Access the Basic Configuration Wizard from the Status window. From there, the end-user can optionally use the Advanced Configuration Wizard to create multiple volumes (virtual drives) on each hard disk drive.

Start the SiI 4726 Manager

MS Windows

1. Select the Start > All Programs > SiI 4726 > SiI 4726 Manager icon to start the Manager.

2. Monitor the status of SiI 4726 Storage Appliances on the Status window.

3. Select menu options or click toolbar buttons and follow the instructions in the remainder of this guide to configure SiI 4726 Storage Appliances. When prompted, enter the administrative password. The default password is admin. The end-user can customize the password. See “Change password” for details.
Mac OS X

1. Launch the Finder and locate the **SiI 4726** program within the **Applications > Utilities > SteelVine** folder. Click the **SiI 4726** icon to start the SiI 4726 Manager.

2. If the launch sequence does not find an active daemon, a warning appears. Click **OK**.

3. Enter the administrator password and click **OK**.

4. A notice appears as the launch sequence attempts to start the daemon. Click **OK**.

If the daemon fails to start, an error appears. Follow the recommendations in the error
message to correct the problem.

5. Monitor the status of Sil 4726 Storage Appliances on the Status window.

![](image1.png)

6. Select menu options or click toolbar buttons and follow the instructions in the remainder of this guide to configure Sil 4726 Storage Appliances. When prompted, enter the administrative password. The default password is `admin`. You end-user can customize your password. See “Change password” for details.

![](image2.png)

**A Look at the Sil 4726 Status Window**

The Status window displays a separate tab for each Sil 4726 Storage Appliance attached to the host computer.

![](image3.png)

**Table 1 Sections of the Status Window**
<table>
<thead>
<tr>
<th>Status Cells</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>System Status section</strong></td>
<td></td>
</tr>
<tr>
<td>Temp</td>
<td>Indicates the current temperature of the Sil 4726 Storage Appliance.</td>
</tr>
<tr>
<td>Fan Speed</td>
<td>Indicates the system fan status. Use this data to monitor possible malfunctions.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Drive Status section</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Box Status</td>
<td>Shows the drive status: Normal, Rebuilding, Unplugged, Needs Rebuild, New Drive, Wrong Slot.</td>
</tr>
<tr>
<td>Drive S/N</td>
<td>Shows the unique serial number assigned by the disk manufacturer.</td>
</tr>
<tr>
<td>Exp. S/N</td>
<td>Shows the expected serial number of the hard disk drive. The daemon compares the Expected and actual Drive serial numbers to detect when a drive’s status changes.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Capacity Information section</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Policy</td>
<td>Shows the storage policy configured for each volume.</td>
</tr>
<tr>
<td>Tota</td>
<td>Shows the combined capacity of the volume.</td>
</tr>
<tr>
<td>Drive #</td>
<td>Shows capacity information for each hard disk drive.</td>
</tr>
<tr>
<td>Capacity</td>
<td>Shows the full amount of storage space (in GB) available on each hard disk drive.</td>
</tr>
<tr>
<td>Volume</td>
<td>Shows the total volume capacity and the drive capacities assigned to each volume.</td>
</tr>
</tbody>
</table>

**Table 2 File Menu on the Status Window**

<table>
<thead>
<tr>
<th>File Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Password</td>
<td>Opens a dialog to establish a new password.</td>
</tr>
<tr>
<td>Scan Devices</td>
<td>Refreshes the status details presented on the Status window.</td>
</tr>
<tr>
<td>Change Connections</td>
<td>Opens a dialog to make remote connections.</td>
</tr>
</tbody>
</table>

**Table 3 Edit Menu on the Status Window**

<table>
<thead>
<tr>
<th>Edit Menu Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configure Box</td>
<td>Opens the Basic Configuration Wizard. From there, the end-user can access the Advanced Configuration Wizard.</td>
</tr>
<tr>
<td>Specify Policy</td>
<td>Opens the Rebuild Policy dialog.</td>
</tr>
<tr>
<td>Specify Email Notification</td>
<td>Sends email notification for the selected items.</td>
</tr>
<tr>
<td>Event Log</td>
<td>Opens the Event Log viewer.</td>
</tr>
<tr>
<td>Specify Firmware</td>
<td>Opens the Firmware Selection dialog.</td>
</tr>
</tbody>
</table>
6 Basic Configuration

This chapter describes the Basic Configuration Wizard and explains how to configure volumes (virtual drives).

A Look at the Basic Configuration Wizard

The SiI 4726 Basic Configuration Wizard is accessible from the Status window and allows volume management. The Basic Configuration Wizard defines volumes based on a selected storage policy. An end-user cannot modify volume counts or capacities. To protect against unintended changes, the SiI 4726 Manager prompts for a password for first time access of the Wizard. The default password is **admin**. (See "Change Password" for additional information on password management.)

<table>
<thead>
<tr>
<th>Button</th>
<th>Tooltip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Configure Box</td>
<td>Opens the <strong>Basic Configuration Wizard</strong>. From there, the end-user can access the <strong>Advanced Configuration Wizard</strong>.</td>
</tr>
<tr>
<td></td>
<td>Specify Policy Information</td>
<td>Opens the <strong>Rebuild Policy</strong> dialog.</td>
</tr>
<tr>
<td></td>
<td>Email Notification</td>
<td>Sends email notification for the selected items.</td>
</tr>
<tr>
<td></td>
<td>Show Event Log</td>
<td>Opens the <strong>Event Log</strong> viewer.</td>
</tr>
<tr>
<td></td>
<td>Specify Firmware</td>
<td>Opens the <strong>Firmware Selection</strong> dialog.</td>
</tr>
</tbody>
</table>

Table 4 Toolbar on the Status Window

**Basic Configuration**

This chapter describes the Basic Configuration Wizard and explains how to configure volumes (virtual drives).

A Look at the Basic Configuration Wizard

The SiI 4726 Basic Configuration Wizard is accessible from the Status window and allows volume management. The Basic Configuration Wizard defines volumes based on a selected storage policy. An end-user cannot modify volume counts or capacities. To protect against unintended changes, the SiI 4726 Manager prompts for a password for first time access of the Wizard. The default password is **admin**. (See "Change Password" for additional information on password management.)
Table 5 Sections of the Basic Configuration Wizard

<table>
<thead>
<tr>
<th>Wizard Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage Policy</td>
<td>Identifies available storage policies to assign to the Sil 4726 configuration.</td>
</tr>
<tr>
<td>Volume List</td>
<td>Shows Volume, Mode (storage policy), and Size details for created volumes. The ‘Total GB’s Left’ field (beneath the volume list) shows the remaining capacity in gigabytes for all the hard disk drives.</td>
</tr>
<tr>
<td>Drive Graph</td>
<td>Displays disk space for each hard disk drive. All space allocated to the same volume appears in a matching color. A hatch pattern indicates a proposed configuration and a solid block indicates an existing volume. The ‘Cap’ field beneath each drive in the drive graph shows the maximum capacity in gigabytes for that hard disk drive.</td>
</tr>
</tbody>
</table>

Table 6 Toolbar on the Basic Configuration Wizard

<table>
<thead>
<tr>
<th>Button</th>
<th>Tooltip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder]</td>
<td>Read a configuration from a file</td>
<td>Reads a saved configuration so the end-user can apply the configuration to the Sil 4726 Storage Appliance.</td>
</tr>
<tr>
<td>![Disk]</td>
<td>Write configuration from system to a file</td>
<td>Saves a configuration to a file on the host computer.</td>
</tr>
<tr>
<td>![RE]</td>
<td>Restore configuration to last commit</td>
<td>Cancels proposed changes.</td>
</tr>
</tbody>
</table>

Table 7 Command Buttons on the Basic Configuration Wizard

<table>
<thead>
<tr>
<th>Button Label</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>To Advanced Mode</td>
<td>Opens the Advanced Configuration Wizard.</td>
</tr>
<tr>
<td>Apply</td>
<td>Submits configuration changes to the Sil 4726 Storage Appliance and closes the Configuration Wizard.</td>
</tr>
<tr>
<td>Cancel</td>
<td>Aborts the changes and closes the Configuration Wizard.</td>
</tr>
</tbody>
</table>
Configure Volumes

Note: Use the Disk Management utility provided by the OS to delete all SiI 4726 partitions - except the un-allocated, un-initialized disk that represents the SteelVine processor. See “Partitioning volumes” for details.

1. Select **Configure Box** from the Edit menu or click the **Configure Box** toolbar button to open the Configuration Wizard.

2. When prompted, enter the administrator password. The default password is **admin**.

3. Select a **storage policy** in the **Storage Policy** frame.
Table 8 Basic Storage Policy Options

<table>
<thead>
<tr>
<th>Storage Policy</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JBOD (bypass)</td>
<td>Creates a logical volume for each physical hard disk drive.</td>
</tr>
<tr>
<td>SAFE (RAID 1)</td>
<td>Creates two volumes. For each volume, one hard disk drive is mirrored onto a second drive. Makes the remaining drive the Hot Spare for both volumes.</td>
</tr>
<tr>
<td>BIG (span)</td>
<td>Concatenates all hard disk drives into a single volume.</td>
</tr>
<tr>
<td>FAST (RAID 0)</td>
<td>Creates one volume that is striped across up to five hard disk drives.</td>
</tr>
<tr>
<td>SAFE and BIG</td>
<td>Concatenates half the available space on four hard disk drives and mirrors that half to the second half of the available space. Makes the remaining drive the Hot Spare.</td>
</tr>
<tr>
<td>SAFE and FAST (RAID 1+0)</td>
<td>Creates one volume consisting of four hard disk drives (data is written to the mirrored disks in a striped format). Makes the remaining drive the Hot Spare.</td>
</tr>
</tbody>
</table>

4. When prompted to acknowledge that the configuration change may result in data loss, click Yes to accept the configuration.

5. Select Save to Config File from the File menu or click the Write configuration for system to a file toolbar button to save the configuration.

6. Click Apply to create the selected configuration. The Volume display will close automatically and the Status window will refresh (within a minute or so).

7. Partition the configured volume(s) to complete the implementation. See “Partitioning Volumes” for details.
This section describes how to use the Advanced Configuration Wizard to apply more than one storage policy to volumes on the SiI 4726 Storage Appliance.

Why Advanced Configuration?

The Basic Configuration Wizard provides six predefined storage policies to quickly configure the SiI 4726 Storage Appliance. Each predefined storage policy allocates the maximum system capacity to the selected storage policy.

Using the Advanced Configuration Wizard, you can configure up to ten volumes - each with different storage policies and capacities. This flexibility provides numerous combinations of performance, redundancy, and capacity to meet your business requirements. For example:

- For applications that produce critical data, redundancy is important. You could use the Basic Configuration Wizard to implement the predefined SAFE, SAFE and FAST, or SAFE and BIG storage policy. This format would allocate all hard disk drives to SAFE volumes. This may be excessive for your needs. Use the Advanced Configuration Wizard to create additional volumes and allocate capacity more efficiently.

- For applications that require hundreds of gigabytes of storage space, the added redundancy of a SAFE configuration’s Hot Spare may not be an acceptable luxury. Use the Advanced Configuration Wizard to create multiple volumes that make use of every gigabyte of available space.

These are just a few of the possible combinations of storage policy and capacity allocations that you can create with the Advanced Configuration Wizard. Experiment with other combinations to allocate the total system capacity to meet your needs.
A Look at the Advanced Configuration Wizard

The Advanced Configuration Wizard is an extension of Basic mode that allows you to create two volumes (virtual drives) on each physical hard disk drive.

Table 9 Sections of the Advanced Configuration Wizard

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Storage Policy</td>
<td>Shows the available storage policies that you can assign to volumes. The options are enabled after you create a new volume or select an existing volume to edit.</td>
</tr>
<tr>
<td>Volume List</td>
<td>Shows Volume, Mode (storage policy), and Size details for currently configured volumes. Select a volume to edit or delete it. The Total GB's Left field beneath the volume list shows the remaining capacity in gigabytes for all the hard disk drives.</td>
</tr>
<tr>
<td>Drive Graph</td>
<td>Displays disk space for each hard disk drive. All space allocated to the same volume appears in a matching color. A hatch pattern indicates a proposed configuration and a solid block indicates an existing volume. Permit volume creation and modification on each hard disk drive:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Hot Spare</strong> check box indicates space on this drive is allocated as rebuild space for the selected SAFE volume.</td>
</tr>
<tr>
<td></td>
<td>• ‘Use’ check box indicates drive membership within a volume.</td>
</tr>
<tr>
<td></td>
<td>• Slider specifies capacity allocated to a volume.</td>
</tr>
<tr>
<td></td>
<td>• Text field shows the capacity specified by manipulating the slider.</td>
</tr>
<tr>
<td></td>
<td>• ‘Cap’ field shows maximum capacity for the hard disk drive.</td>
</tr>
<tr>
<td></td>
<td>• ‘Vol#’ shows the virtual volume with which each hard disk drive is associated.</td>
</tr>
</tbody>
</table>
### Table 10 Toolbar Buttons on the Advanced Configuration Wizard

<table>
<thead>
<tr>
<th>Button</th>
<th>Tooltip</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Folder Icon]</td>
<td>Read a configuration from a file</td>
<td>Reads a saved configuration into the Advanced Configuration Wizard so you can apply the configuration to the SiI 4726 Storage Appliance. Available in Basic and Advanced modes.</td>
</tr>
<tr>
<td>![Diskette Icon]</td>
<td>Write configuration for system to a file</td>
<td>Saves a configuration to a file on the host computer. Available in Basic and Advanced modes.</td>
</tr>
<tr>
<td>![Refresh Icon]</td>
<td>Restore configuration to last Commit</td>
<td>Cancels proposed changes. Available in Basic and Advanced modes.</td>
</tr>
<tr>
<td>![Add New Icon]</td>
<td>Create a new volume</td>
<td>Creates a new volume on which to set the storage policy and capacity. You can create up to 2 volumes on each hard disk drive (10 total).</td>
</tr>
<tr>
<td>![Edit Icon]</td>
<td>Edit selected volume</td>
<td>Permits the storage policy and capacity of an existing volume to be modified.</td>
</tr>
<tr>
<td>![Delete Icon]</td>
<td>Delete selected volume</td>
<td>Deletes the volume that is currently selected in the volume list.</td>
</tr>
<tr>
<td>![Delete All Icon]</td>
<td>Delete all volumes</td>
<td>Deletes all configured volumes.</td>
</tr>
<tr>
<td>![Copy Icon]</td>
<td>Copy configuration from other device in the system</td>
<td>Copies the configuration of one SiI 4726 Storage Appliance to the current SiI 4726 Storage Appliance.</td>
</tr>
</tbody>
</table>

### Table 11 Command Buttons on the Advanced Configuration Wizard

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![To Basic Mode Icon]</td>
<td>To Basic Mode</td>
</tr>
<tr>
<td>![Update Volume Icon]</td>
<td>Update Volume</td>
</tr>
<tr>
<td>![Cancel Icon]</td>
<td>Cancel</td>
</tr>
</tbody>
</table>

#### When configuring a volume (create a new volume or edit a selected volume)

- **Update Volume**: Applies the selected storage policy to a specific portion of a hard disk drive as a proposed configuration.
- **Cancel**: Aborts the pending changes and returns the Wizard to the point where you can perform different advanced configuration functions.

#### After configuring a volume

- **Apply**: Submits configuration changes to the SiI 4726 Storage Appliance, closes the Wizard, and displays the updated configuration on the Status window.
- **Cancel**: Aborts the in-progress changes and closes the Wizard.
Configure Multiple Volumes

The Advanced Configuration Wizard allows many combinations of storage policies and capacities. This procedure shows how to modify a basic SAFE configuration so that it contains several volumes, each with different storage policies. This example illustrates one possible combination that allocates all of the system’s available capacity to:

- One 50-gigabyte (GB) SAFE volume on drives 0 and 1, with no reserved space for a Hot Spare.
- One FAST volume that uses the remaining capacity on drives 0 and 1.
- One BIG volume that uses all of the capacity on drives 2, 3, and 4.

The same sequence of steps applies to any configuration you choose to implement; only the storage policy and capacity allocation vary for different configuration options.

Note: Before reconfiguring an existing Sil 4726 Storage Appliance with a new configuration, back-up the data. Use the Disk Management utility provided by your OS to delete all Sil 4726 partitions - except the unallocated, un-initialized disk that represents the SteelVine processor. Once the configuration and partitioning of the new volumes has taken place, it is safe to restore the backed-up data to the new configuration. See “Partitioning volumes” for details.

1. Click the Configure Box toolbar button to open the Basic Configuration Wizard.
2. Click **To Advanced Mode** to open the Advanced Configuration Wizard.

3. Select the “Delete all volumes” from the toolbar.
4. When prompted to confirm the deletion of the volumes, click **Yes**.

![Sil 4726 Manager](image1)

5. Select “Create a new volume” from the toolbar.

![Create a new volume](image2)
6. Select SAFE (RAID 1) as the Storage Policy. Click on the “Use” check boxes underneath Drives 0 and 1. Move the slide to 50.

Tip: Click to the right or left of the slider within the slider’s channel to make half-GB changes.

7. Click Update Volume.

8. When prompted whether to create a Hot Spare for the SAFE volume, click No.

In some configurations, the end-user may want the added redundancy of a Hot Spare. The goal of this example is to use all available system capacity to deliberately avoid the Hot Spare.
9. Click the **Create a New Volume** toolbar button.

Cross-hatches identify allocated space for updated volumes (not yet saved).

Light solid colors identify unallocated disk space.
10. Select the **FAST** radio button in the Storage Policy section.

11. Select the ‘Use’ check box beneath both Drive 0 and Drive 1. This example illustrates two-drive striping.

12. Move the slider beneath Drive 0 all the way to the right to allocate the remaining capacity on the two drives to the Fast volume.

   If you wish, you can allocate less than the total remaining capacity to the new volume. However, doing so makes the unallocated capacity unavailable and unused.

13. Click **Update Volume**.
14. Click the **Create a New Volume** toolbar button.

15. Select the **BIG** radio button in the Storage Policy section.

16. Select the ‘Use’ check box beneath Drive 2, Drive 3, and Drive 4 to allocate all of the remaining system capacity to the **BIG** volume.

17. Click **Update Volume**.

---

*Note: Only the last Volume listed (in the above example, Volume 2) can be edited. In order to edit Volume 1, Volume 2 must be deleted. In order to edit Volume 0, all Volumes must be deleted and the end-user will need to start with a New Volume (refer to list item 9 - 13 for more details).*
18. Click the **Write Configuration for System to a File** toolbar button to save the configuration.

19. Click **Update Volume** to create the multi-volume configuration, close the Wizard, and display the volumes in the Status window (within a minute or so).

20. Partition the configured volumes to complete the implementation. See “Partitioning Volumes” for details.
**Manage Configuration Files**

The Basic Configuration Wizard provides menus and icons to manage configuration files.

- The **Read Config File** command from the File menu in the Basic Configuration Wizard imports a configuration file so that the end-user can restore a previously saved configuration (storage policy).

- The **Save to Config File** command from the File menu in the Basic Configuration Wizard exports an SiI 4726 configuration to a file.

Each of the procedures in the “Basic Configuration” chapter prompts you to save a configuration file.

**Import a configuration file**

*Note: The end-user must have previously saved a configuration file so that one is available to import it. See “Save a configuration file” for details.*

1. Select **Configure Box** from the Edit menu or click the **Configure Box** toolbar button in the Status window to open the Basic Configuration Wizard.

2. Select **Read Config File** from the File menu in the Basic Configuration Wizard.

3. Navigate to the required file and click **Open** to import it. The Basic Configuration Wizard provides notice of a successful import and graphically displays the imported volumes.

4. Click **OK** to implement the imported configuration.
Save a configuration file

1. Select **Configure Box** from the Edit menu or click the **Configure Box** toolbar button in the Status window to open the Basic Configuration Wizard.

2. Select **Save to Config File** from the File menu in the Basic Configuration Wizard.

3. Navigate to the appropriate directory, specify a file name in the **File Name** text box, and click the **Save** button.
Partitioning Configured Volumes

This chapter explains how to partition volumes after configuring them with the SiI 4726 Manager. The end-user must partition volumes for the host computer’s operating system before one can store data on the volumes. Refer to the operating system documentation for further guidance.

Partition a Volume

MS Windows

Important: Before reconfiguring a volume, back up the data and delete previously defined SiI 4726 partitions. Do not, however, delete the partition that represents the SteelVine processor (the “Not Initialized” disk with no capacity allocated to it). After the end-user configures and partitions the new volumes, S/he can restore the backed-up data to the new configuration.

1. Right-click the My Computer icon and select Manage from the pop-up window.
2. From the Computer Management window select **Disk Management** under **Storage** to open Windows Disk Manager.
Note: The Disk numbers in the Windows Disk Manager may be different from the Volume numbers shown in the SiL 4726 Manager Status window, the Basic Configuration Wizard, and the Advanced Configuration Wizard. Be sure to select the correct disk based on the expected disk capacity to create a partition.

3. Right-click on the configured disk’s unallocated space and select **New Partition**. If the New Partition option is not available, select the disk and Initialize it first. To do this, right-click on the disk item and select "Initialize Disk".

4. Click **Next** to start the Partition Wizard.
5. Select the Primary or Extended option and click **Next**.

6. Specify the partition size. By default, the partition occupies the entire volume. Click **Next**.
7. Assign a drive letter or mount path and click **Next**.
8. Select file system and name the partition and click **Next**.

![New Partition Wizard](image)

**Format Partition**

To store data on the partition, you must format it first.

Choose whether you want to format this partition, and if so, what settings you want to use.

- **Do not format this partition**
- **Format this partition with the following settings:**

  - **File system:** NTFS
  - **Allocation unit size:** Default
  - **Volume label:** New Volume

- **Perform a quick format**
- **Enable file and folder compression**

![Next button](button)

9. Review the file system settings and click **Finish** to create the logical partition.

![Completing the New Partition Wizard](image)

- **You have successfully completed the New Partition Wizard.**
- **You selected the following settings:**
  - **Partition type:** Primary partition
  - **Disk selected:** Disk 1
  - **Partition size:** 156125 MB
  - **Drive letter or path:** F:
  - **File system:** NTFS
  - **Allocation unit size:** Default
  - **Volume label:** New Volume
  - **Quick format:** Yes

To close this wizard, click **Finish**

![Finish button](button)

10. Repeat steps 1 through 9 to partition any remaining disks you configured in the SiI 4726 Manager. Remember, do not partition the disk that represents the SteelVine processor.
1. Launch Disk Utility from Application > Utilities folder.

2. Select a configured disk and click the Partition tab.

3. Select 1 Partition from the Volume Scheme drop-down list.

4. Enter a name for the volume in the Name field.

5. Select Mac OS Extended (journalled) from the Format drop-down list.

6. Specify the size of the partition in the Size field.

7. Click the Partition button.
8. Click **Partition** to acknowledge the warning.

![Disk Utility partition window](image)

Disk Utility mounts the created partition and represents it with an icon on the desktop. The icon is labeled with the partition name.

9. Repeat steps 1 through 8 to partition any remaining disks you configured in the Sil 4726 Manager. Remember, do not partition the 320.0 KB Config Disk that represents the SteelVine processor.
9 Administering the Sil 4726

This chapter explains how to perform administrative functions in the Sil 4726 Manager.

Change Password

The Sil 4726 Manager limits configuration access with a password prompt. The password information is stored locally on the server running the daemon. The default password is admin.

1. Select Change Password from the File menu.

2. Enter the current password (or use ‘admin’ if the default password has not been changed).

3. Enter the new password of 5 or more characters in both fields.

4. Click OK to implement the new password.
Manage Client Connection to the Daemon

The SiI 4726 Manager consists of two modules:

- Daemon
- User interface

The daemon monitors the status of SiI 4726 Storage Appliances and performs SAFE volume rebuilds. By default, the user interface attaches to a daemon running on the same host to display the information gathered by the daemon. The end-user can configure the user interface to display information tracked by a daemon running on a remote host. Having the user interface remote to the daemon allows remote monitoring for system fan and hard disk drive failures. Identification of a failed part will allow the service provider to replace failed components before further complications arise.

Prerequisites

The end-user should have the following before a remote connection can be established:

- The daemon is installed and running on a host computer connected to the SiI 4726 Storage Appliance.
- The user interface is installed and running on a remote host computer.
- A TCP/IP connection can be established between the daemon and the user interface. The daemon listens for connections on TCP port 51115. Do not change this port number.

Set up a remote connection

1. In the Status window, select Change Connection from the File menu.

2. Enter the hostname or IP address of the PC hosting the daemon. Click OK.

The user interface will establish the requested connection and will display the information gathered by the remote daemon in the Status window.
10 Configure SAFE Volume Rebuild

Storage Policy

This Sil 4726 feature is provided to manage rebuilds of SAFE volumes.

When is a rebuild necessary?

A rebuild is initiated to restore data redundancy for a SAFE volume that has entered a vulnerable state. In a vulnerable state, one of the two mirrored disks goes offline or is inaccessible. Although the SAFE volume remains available during the rebuild process, the volume is susceptible to data loss through damage of the remaining disk until data redundancy is restored through a rebuild. Host access takes precedence over the rebuild process. If continuing to use the SAFE volume during the rebuild, the rebuild process will take a longer time to complete.

Note: The rebuild feature also applies to other SAFE policies such as SAFE and BIG and SAFE and FAST.

What happens during a rebuild?

The rebuild process restores data redundancy by first utilizing space allocated for a Hot Spare. In case Hot Spare space does not exist or has already been rebuilt, the SteelVine processor rebuilds to empty space on a hard disk drive other than the one containing vulnerable data. Following a rebuild, it is not necessary to designate space to a Hot Spare for a subsequent rebuild to occur.

In this example, the daemon started a rebuild of Volume #1 after a failure of Disk #3. Once the end-user replaces Disk #3 with a new hard disk drive, the SteelVine processor will initiate a rebuild to Drive #3.
Note: Once the daemon rebuilds to a designated Hot Spare, a designated Hot Spare will not exist and the SteelVine processor will rebuild to empty space.

With **Automatic Rebuild** and **Immediate Rebuild** options selected, the daemon automatically initiates an immediate rebuild. If the end-user wants the daemon to delay the rebuild until after the first write to the **SAFE** volume, select the **Rebuild Only If Needed** option. The latter setup allows temporary removal of a hard disk drive without requiring a rebuild. To minimize the possibility of data loss, the rebuild process should be set up to start immediately.

With **Manual Rebuild** selected, the end-user decides when to initiate rebuild following a rebuild prompt. Unless the SiL 4726 Manager is actively monitored, the **Automatic** rebuild should be set up to minimize the possibility of data loss.

Note: In case the end-user selects **No** in response to a rebuild prompt, select **Scan Devices** from the **File** menu of the **Status** window to trigger a new prompt.

If a power failure interrupts a rebuild, the daemon will restart the rebuild process.

### Configure a rebuild

1. Select **Specify Policy** from the Edit menu of the Status window.
2. Select one of the following policy options:
   - The **Manual Rebuild** radio button requires a user to manually initiate a rebuild of the volume.
   - The **Automatic Rebuild** option forces the daemon to initiate the rebuild process automatically and minimize the possibility of data loss.

3. If the **Automatic Rebuild** option is selected, the end-user will have the following additional choices:
   - **Immediate Rebuild** causes the daemon to rebuild immediately following detection of an offline hard disk drive.
   - The **Rebuild Only If Needed** delays the rebuild for a SAFE volume with an offline hard disk drive until the write occurs to the SAFE volume.

4. Click the **Accept** button to commit the selected options.

The daemon uses the specified rebuild policy to maintain redundancy. The Status window displays a rebuild in progress.
11 Email Notification

The Email Notification feature allows the end-user to have the Sil 4726 Manager send an email if any of the following conditions/situations occur:

- Partition Rebuild Start
- Partition Verify Start
- Partition Rebuild Resume
- System Fan Too Slow
- No Boxes Found
- Drive Unplugged
- Partition Rebuild Complete
- Partition Verify Complete
- Temperature Too High
- Power supply Fan Too Slow
- Box Removed
- Drive Inserted

Each of the above conditions can be customized for sending options as well as the message that is sent. Below is an example of the Setup Email Notification screen.
Setting-up Email Notification

1. The box available for the SMTP Server Name can be left blank. The Si 4726 Manager will perform a DNS lookup and automatically find the correct address.

   SMTP Server Name: [Use DNS lookup if blank]

2. The box available for the SMTP Server Port# uses Port 25 as a default.

   SMTP Server Port #: 25 [Use 25 if blank]

3. The From, To, and CC boxes are for specifying the intended receivers of the condition notifications.

   From: 
   To: 
   CC: 

   Note: In the From: box, the end-user should type in his/her own email address.

4. Select ‘Test Email’ at the bottom of the screen to verify that you have correctly set-up
the email portions of this feature.

5. The Email Notification feature also allows the end-user to customize a message for each of the line items (of which each has its own default message already built in). For instance, if the end-user wants to edit the message for ‘Drive Unplugged’...

a. Click on the ‘Message’ box.

b. The following will appear:

![Email Message for Drive Unplugged]

The message information can be customized to suit the end-user’s needs. The Daemon can extract the following data from the SiI 4726 hardware:

- \$B Æ Box serial number
- \$T Æ Current Temperature
- \$DS Æ Drive serial number
- \$SF Æ System Fan OK Flag
- \$DN Æ Drive id [slot #]
- \$PSF Æ Power Supply fan OK Flag
- \$V Æ Current volume

c. The message information can be customized to suit the end-user’s needs. The Daemon can extract the following data from the SiI 4726 hardware:

- \$B Æ Box serial number
- \$T Æ Current Temperature
- \$DS Æ Drive serial number
- \$SF Æ System Fan OK Flag
- \$DN Æ Drive id [slot #]
- \$PSF Æ Power Supply fan OK Flag
- \$V Æ Current volume

d. If there is information that the end-user would like included in the error message, s/he can enter it themselves by typing in a selected message code listed above. For instance: to put in the ‘Box Serial Number’, type in the descriptive text followed by the message code as demonstrated below.
Receiving an Email Notification

When one of the conditions/situations occurs, a pop-up appears on the host computer stating that an email has been sent.
Note: The end-user must click 'OK' to remove the pop-up from the screen.

The email received from the SiI 4726 will look like the following:

From:  yourname@yourcompany.com   Sent:  Wed 12/7/2005 3:12 PM
To:  Your Name
Cc:  
Subject:  SiI 4726 Manager Event Message

SiI 4726: 252219
Drive:  Slot #3
Temperature:  27 degrees C
System Fan Speed:  Good Speed
Power-Supply Fan Speed:  Good Speed
Box Serial Number:  252219

The drive was unplugged.
## 12 Install New Firmware & Software

**Firmware Update**

Note: Do not power off or access the SiI 4726 Storage Appliance while upgrading firmware.

1. Click the **Specify Firmware** toolbar button or select **Specify Firmware** from the Edit menu of the Status window.

   ![Firmware Selection dialog](image)

   The Firmware Selection dialog shows all of the SiI 4726 Storage Appliances attached to the host, the integrated circuit (IC) revision, and the current firmware installed on each Storage Appliance.

2. Select the SiI 4726 Storage Appliance that requires a firmware upgrade.

3. Click the **Browse** button next to the **Update firmware from file** text box, navigate to the new firmware file you wish to load from a CD or hard disk drive, and select the .bin file.
4. Click **Install Firmware** to begin the upgrade.
5. Click **OK** to dismiss a message box that states the firmware was successfully downloaded.

### Install New Sil 4726 Manager Software

Before the end-user installs new software, the current version will need to be un-installed. The un-installation process stops the daemon so it can be removed along with the user interface. The new version of the daemon starts automatically when the new software has been installed.

#### Uninstall Current Software

**MS Windows**

1. Exit the Sil 4726 Manager.
2. Select **Start > Control Panel > Add or Remove Programs** from the Windows taskbar.
3. Select the Sil 4726 Manager program and click **Remove**.
4. Select the **Remove** radio button and click **Next**.
5. Click **OK** to confirm the complete removal of the Sil 4726 Manager.

#### Confirm Uninstall

**Confirm Uninstall**

Do you want to completely remove the selected application and all of its features?

- **OK**
- **Cancel**
6. Click **Finish** to complete the un-installation process.

7. Optionally, move or delete the .xml configuration files that the InstallShield Wizard left in the installation directory (by default, C:\Program Files\SteelVine\SiI 4726 Manager).

**Mac OS X**

1. Optionally, move saved.xml configuration files from the **Applications > Utilities > SteelVine > SiI 4726 Manager Resources** folder to another location.
2. Drag the **Applications > Utilities > SteelVine** folder to the trash to remove the GUI modules and supporting files
3. Drag the **Library>StartupItems>SteelVineDaemon** folder to the trash to remove the daemon startup scripts.

**Install new software**

See the Quick Install Guide for install instructions.
13 Editing the UserConfig.xml

The UserConfig.xml file is used to define the Status Screen Title Bar and allow configuration of the Policy Change as well as the Advanced Configuration features.

The UserConfig.xml file can be found in the following location: C:\Program Files\SiI4726\SiI 4726 Manager\SiI 4726 Config

To edit this file, Right Click on the file name, move the mouse to Open With, and select Notepad.

Once this file is open, the end-user will see the following:

```xml
<SII4726>
  <StatusScreenTitleBar>SiI 4726 Manager</StatusScreenTitleBar>
  <AllowPolicyChanges>true</AllowPolicyChanges>
  <AllowAdvancedConfig>true</AllowAdvancedConfig>
</SII4726>
```
The ‘StatusScreenTitleBar’ is where the end-user can change the Name seen at the top of the GUI. To edit this feature, change the XML tag text string that says ‘Sil 4726 Manager’. 

\[
\begin{align*}
\text{<StatusScreenTitleBar> } & \quad \text{SiI 4726 Manager} \\
\text{<StatusScreenTitleBar> } & \quad \text{Your Company Name}
\end{align*}
\]

The ‘AllowPolicyChanges’ – True – turns on the Policy feature. If the end-user changes the XML tag value to False, the Policy Icon will not appear in the GUI and the feature will not be available.

\[
\begin{align*}
\text{<AllowPolicyChanges> True} & \quad \text{<AllowPolicyChanges> False}
\end{align*}
\]

The ‘AllowAdvancedConfig’ – True – turns on the Advanced Config feature. If the end-user changes the XML tag value to False, the general Configure feature will still be available, but the Advanced button (inside the Configuration feature) will not be available.

\[
\begin{align*}
\text{<AllowAdvancedConfig> True} & \quad \text{<AllowAdvancedConfig> False}
\end{align*}
\]

Note: If the file is missing from the working directory, the GUI will allow both policy changes and advanced mode, as well as the status screen title to be set to “Sil4726”. If there are any errors in the XML tag value, the Advanced Configuration button will not be available in the Configuration Setup.

If there is an error in the XML tag value, a pop-up window will appear notifying the end-user of the error and the tag where it can be found.
Creating a Splash Screen

The end-user can further customize the Sil 4726 Manager by creating a personalized splash screen.

1. Create the logo for your splash screen – there are no image size limitations
2. Save the logo as ‘UserLogo.xpm’
   The .xpm file type is UNIX based
3. Put the UserLogo.xpm file in the following location:
   C:\Program Files\Sil4726\Sil 4726 Manager\Sil 4726
   Config

The splash screen will come up each time the end-user starts the Sil 4726 Manager. It will stay up for 2 seconds.

14 Monitor and Troubleshooting

This chapter describes Status window color codes, LED indicator states, and event log messages that
Monitor the Sil 4726 Storage Appliance

Monitor drive status

The color of the drives in the Status window indicates the status of the hard disk drives.

Table 12 Drive Status

<table>
<thead>
<tr>
<th>Color</th>
<th>State</th>
<th>Definition</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Normal</td>
<td>Drive is active.</td>
<td></td>
</tr>
<tr>
<td>Red</td>
<td>Needs Rebuild</td>
<td>Drive is in a failed state. That is, a write has occurred to a SAFE volume while the disk drive was offline.</td>
<td>Replace the failed hard disk drive.</td>
</tr>
<tr>
<td>Gray or Red</td>
<td>Unplugged</td>
<td>Drive is offline or unplugged. The background will appear red after a write to the volume.</td>
<td>Verify the disk is securely in the bay. Otherwise, replace as necessary.</td>
</tr>
<tr>
<td>Light Blue</td>
<td>New drive</td>
<td>New drive.</td>
<td></td>
</tr>
<tr>
<td>Yellow</td>
<td>Rebuilding</td>
<td>Drive is being rebuilt.</td>
<td></td>
</tr>
<tr>
<td>Purple</td>
<td>Wrong slot</td>
<td>There is a mismatch between the Serial # and Expected Serial # because a hard disk drive has been installed into the wrong bay.</td>
<td>Install the correct disk drive into the bay.</td>
</tr>
</tbody>
</table>
Monitor temperature

The SiI 4726 Storage Appliance uses the following colors to indicate temperature status.

Table 13 Temperature Status

<table>
<thead>
<tr>
<th>Color</th>
<th>Definition</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Temperature is normal.</td>
<td></td>
</tr>
<tr>
<td>Yellow</td>
<td>Temperature is greater than 50º Celsius (122º Fahrenheit).</td>
<td>Remove object(s) that interfere with airflow around the SiI 4726 Storage Appliance.</td>
</tr>
<tr>
<td>Red</td>
<td>Temperature is greater than 53º Celsius (127º Fahrenheit).</td>
<td>Ensure constant airflow around the SiI 4726 Storage Appliance. If there is no airflow, replace the fan. Identify the drive causing the temperature increase and replace it.</td>
</tr>
</tbody>
</table>

Monitor fan status

The SiI 4726 uses the following colors and values to indicate fan status.

Table 14 Fan Status

<table>
<thead>
<tr>
<th>Color</th>
<th>Value</th>
<th>Definition</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>System + PS</td>
<td>Both system and power supply fans are functioning within limits.</td>
<td></td>
</tr>
<tr>
<td>Red</td>
<td>System</td>
<td>The system fan is not spinning or spinning slower than expected.</td>
<td>Contact point of sale for repair.</td>
</tr>
<tr>
<td>Red</td>
<td>PS</td>
<td>The power supply fan is not spinning or spinning slower than expected.</td>
<td></td>
</tr>
<tr>
<td>Red</td>
<td>System + PS</td>
<td>Both system and power supply fans are not spinning or spinning slower than expected.</td>
<td></td>
</tr>
</tbody>
</table>
Front Panel LED Indicators

Each disk drive and the host connection have two LEDs to indicate drive status and/or host communication status. LED 0 is on the left and is typically blue; LED 1 is on the right and is typically green. In addition, there is one error-condition LEDs, labeled ‘!’ and the SiI 4726 power on indicator ‘OK’.

Figure 2: LEDs

![LEDs Diagram]

When the SiI 4726 Storage Appliance is powered on, the host scans the disks in sequence, as indicated by a brief flash of lights on LED 1. Once the host scan is complete, LED 1 is lit for each drive present. During disk operations, LED 0 flashes as data is transferred to and from the drive and the host.

If a SAFE volume is being rebuilt, LED 1 blinks slowly on both mirrored disks.

Table 15 Status Indicators for 0 and 1 LEDs

<table>
<thead>
<tr>
<th>LED 0</th>
<th>LED 1</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>Off</td>
<td>Power on, no device attached</td>
</tr>
<tr>
<td>Off</td>
<td>On</td>
<td>PHY communication established (Activity = LED0 On)</td>
</tr>
<tr>
<td>On</td>
<td>Blink</td>
<td>Rebuild</td>
</tr>
<tr>
<td>Blink</td>
<td>Blink</td>
<td>Error</td>
</tr>
</tbody>
</table>

Table 16 Status Indicators for ! and OK LEDs

<table>
<thead>
<tr>
<th>!</th>
<th>OK</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Off</td>
<td>On</td>
<td>Startup or ON indication. OK LED will flash during reset and will remain green in all other cases.</td>
</tr>
<tr>
<td>On</td>
<td></td>
<td>ERROR. The ‘!’ LED will light as a result of an EEPROM error during boot or following a runtime error.</td>
</tr>
</tbody>
</table>
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LEDs</strong></td>
<td></td>
</tr>
<tr>
<td>Green “OK” LED does not light.</td>
<td>Confirm power at the outlet, verify power connection, and try an alternate power cable.</td>
</tr>
<tr>
<td>Red “!” LED is lit.</td>
<td>Power cycle the SiI 4726 Storage Appliance and to reload the firmware.</td>
</tr>
<tr>
<td>SiI 4726 HOST LED 1 is not lit.</td>
<td>See HBA connection below.</td>
</tr>
<tr>
<td>LED 1 continuously flashes for one or more drives.</td>
<td>LED1 flashes during a Safe volume rebuild. If the LED flashes while the SiI 4726 Storage Appliance is not rebuilding, verify the eSATA connection and try an alternate eSATA cable.</td>
</tr>
<tr>
<td>LED 1 remains off for one or more drives.</td>
<td>Swap drives to ensure that this is not a drive bay or LED problem. If the LED off state is specific to a drive, evaluate the drive for failure.</td>
</tr>
<tr>
<td><strong>Fan</strong></td>
<td></td>
</tr>
<tr>
<td>Rear fan is not running.</td>
<td>Confirm the outlet is powered, verify power connections, and try an alternate power cable.</td>
</tr>
<tr>
<td>Power supply fan is not spinning.</td>
<td></td>
</tr>
<tr>
<td><strong>HBA connection</strong></td>
<td></td>
</tr>
<tr>
<td>SiI 4726 Storage Appliance is not recognized by HBA BIOS.</td>
<td>Verify the OK LED status to confirm power.</td>
</tr>
<tr>
<td></td>
<td>Verify the eSATA connection and try an alternate eSATA cable.</td>
</tr>
<tr>
<td></td>
<td>Verify HBA BIOS recognizes an empty SiI 4726 Storage Appliance.</td>
</tr>
<tr>
<td></td>
<td>Turn off PCI bus power save mode in the host BIOS.</td>
</tr>
<tr>
<td>Troubleshoot the HBA:</td>
<td></td>
</tr>
<tr>
<td>• Connect to an alternate SATA port.</td>
<td></td>
</tr>
<tr>
<td>• Connect an alternate device to the HBA.</td>
<td></td>
</tr>
<tr>
<td>• Remove all other PCI peripherals to rule out interference.</td>
<td></td>
</tr>
<tr>
<td>• Move the HBA to an alternate PCI-X slot.</td>
<td></td>
</tr>
<tr>
<td>• Try the HBA in a PCI slot.</td>
<td></td>
</tr>
<tr>
<td>Operating system does not recognize one or more of the SiI 4726 volumes.</td>
<td>Verify HBA BIOS recognizes an empty SiI 4726 Storage Appliance.</td>
</tr>
<tr>
<td></td>
<td>Before deleting or altering volumes with the Configuration Wizard, delete partitions residing on the volume. To delete partitions, use the operating system’s Disk Manager.</td>
</tr>
<tr>
<td></td>
<td>Ensure the HBA driver is current. The SV-HBA3124 driver is available at <a href="http://www.steelvine.com">www.steelvine.com</a>.</td>
</tr>
<tr>
<td>Troubleshoot driver:</td>
<td></td>
</tr>
<tr>
<td>• Verify driver active status. For Windows, Device Manager should show the SCSI icon next to the HBA. For Mac OS X, Disk Utility should show a SCSI Connection ID for the virtual disks on the physical drives. Error messages during the driver installation would have indicated issues.</td>
<td></td>
</tr>
<tr>
<td>• Resolve resource conflicts (IRQ, DMA, or I/O).</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Identify maximum SATA disk drive capacity supported by the operating system and ensure the volume size meets the limits.</td>
</tr>
<tr>
<td></td>
<td>Verify port multiplier support in the HBA.</td>
</tr>
</tbody>
</table>

15-1 Using the SATARAID5 Manager (For Windows only)

This section explains how to use the SATARAID5 Manager graphical user interface (GUI) to create and manage RAID groups. Please install the SATARAID5 Manager software as explained in the SATARAID5 Quick Installation Guide for your computer’s operating system before you perform these tasks. Refer to Appendix A for information about managing the Flash BIOS of the RAID controller on a Windows system.

*Note:* Be sure to download and install the latest Java Run-Time Environment for your system.

Launching the SATARAID5 Manager

The SATARAID5 Manager consists of a daemon and Java-based GUI applet. Depending on the operating system, the daemon runs as Windows Service or a script-launched background process responsible for monitoring of the local SATARAID5 driver.

**Windows Systems**

On a Windows system, the SATARAID5 Manager GUI shortcut is installed in the Windows Startup folder to be launched automatically whenever your system is rebooted. To manually start the SATARAID5 Manager, click the **Start** button, open the SATARAID5 Manager program group, and click on the SATARAID5 icon.

**Macintosh Systems**

On a Macintosh system, the SATARAID5 Manager software is installed into the Applications / Utilities / Silicon Image / SATARAID5 folder. You can launch it by navigating to that folder and double-clicking on the icon for the SATARaid5.jar file.

**Linux Systems**

On a Linux system the SATARAID5 Manager and daemon can be installed into any subdirectory. Before launching the SATARAID5 Manager, the driver must be installed and the daemon must be running in background. If you are using a bootable version of the SATARAID5 driver, it is already included in your Linux kernel. If you are not using a bootable version of the SATARAID5 driver, you must manually load the driver by typing the following command:

- `insmod si3XXXr5.ko` (where “3XXX” refers to your specific SATA controller chip)

Then, the daemon must be started. If the daemon has been incorporated into the startup scripts (typically included within the `/etc/rc` directory structure, it will start automatically when you boot your system. Otherwise, you must manually start the daemon in a background mode by typing the following command:

- `.SATARaid5ConfigServer`

Finally, you can launch the SATARAID5 Manager by typing the following command:

- `java -jar SATARaid5Manager`

*Note:* The SATARAID5 Manager uses TCP port number “4242” for sending commands to the daemon and obtaining status. If a firewall is active on your system, be sure to enable access to that port number before launching the SATARAIDS Manager.
When you start the SATARAID5 Manager GUI, the following divided window appears.

---

**Note:** All of the SATARAID5 Manager screen illustrations are shown for Microsoft Windows. The outer frame and buttons may appear slightly different on other operating system platforms. The number of channels shown in this screen will vary according to the type of RAID controller that is installed in your system. The Legacy Support menu item is not available on Macintosh systems.

The left RAID Groups window identifies SATA host adapters and configured RAID groups. If more than one Silicon Image Host Bus Adapter is installed, you can switch between them by selecting any controller. This also displays the RAID Groups currently defined for each controller window. Select a RAID Group to display the segments associated with that volume in the Device Configuration window on the right. The Device Configuration window identifies all physical drives and their partitions. If the controller supports SATA-II Port Multipliers, there may be more than one device ID per SATA channel.

Throughout the Manager, different colors indicate the status of components as follows.

<table>
<thead>
<tr>
<th>Color</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Good. The component and all subcomponents are functioning correctly.</td>
</tr>
<tr>
<td>Yellow</td>
<td>Warning. The component, or at least one subcomponent, has failed or become unavailable and requires service.</td>
</tr>
<tr>
<td>Red</td>
<td>Failed. The component, or at least one subcomponent, has failed.</td>
</tr>
<tr>
<td>Blue</td>
<td>Pass-Thru device. The component is valid, but it does not contain any RAID metadata, so it will function as an ordinary hard disk drive.</td>
</tr>
<tr>
<td>White</td>
<td>A square with capacity shows an unallocated driver reserved for configuration into a RAID set. An empty square presents a free slot that will be filled by adding a hard disk drive to the system.</td>
</tr>
<tr>
<td>Gray</td>
<td>Unused.</td>
</tr>
</tbody>
</table>

---

**Note:** Throughout this manual, the term “right-click” refers to using the secondary button on your mouse to perform the indicated operation. On a Windows or Linux system, use the mouse button that
you have defined to be the “right” button (which by default is on the right side of the mouse, unless you have changed the primary and secondary buttons using Control Panel > Mouse on Windows). On a Macintosh system, press and hold the COMMAND (Apple) button and click the mouse.
Creating RAID Groups

Redundant Array of Independent Disks (RAID) technology allows one or more disks to be combined into a logical volume, which provides greater performance and/or protection than standard disk drives. These volumes, known as RAID Groups, appear like regular disk drives to the operating system and can be partitioned, formatted and used just like any other disk. The RAID complexity is hidden within the driver.

**Note:** The maximum allowable size of a RAID group that can be created by the SATARAID5 Manager is 144,115,188,075,855,872 bytes (which represents $2^{48}$ bit addressability). However, some Linux platforms may limit the maximum size of a volume to 2TB, so the largest allowable size of a RAID group is 2,199,023,255,552 bytes.

### RAID Levels

There are several methods of combining disks, each with its own advantages and disadvantages. Each method is referred to as a RAID “level,” such as RAID 1 or RAID 5. The details of each level are summarized below and detailed in the following sections.

<table>
<thead>
<tr>
<th>RAID Level</th>
<th>Advantages</th>
<th>Disadvantages</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID 0</td>
<td>High performance, low cost.</td>
<td>No data protection.</td>
</tr>
<tr>
<td>RAID 1</td>
<td>Excellent data protection.</td>
<td>High cost.</td>
</tr>
<tr>
<td>RAID 5</td>
<td>Good data protection, good value.</td>
<td>Performance degradation on writes.</td>
</tr>
<tr>
<td>RAID 10</td>
<td>High performance, excellent data protection.</td>
<td>High cost.</td>
</tr>
<tr>
<td>Concatenated</td>
<td>Good performance, low cost, large volume size.</td>
<td>No data protection.</td>
</tr>
<tr>
<td>JBOD</td>
<td>Same as single disk.</td>
<td>Same as single disk.</td>
</tr>
</tbody>
</table>

### Disk Striping (RAID 0)

Striping is a performance-oriented, non-redundant data mapping technique. While Striping is discussed as a RAID Group type, it is does not provide any fault tolerance. With modern SATA and ATA bus mastering technology, multiple I/O operations can be performed in parallel, enhancing data throughput. Striping arrays use multiple disks to form a larger virtual disk. The figure below illustrates a three-disk stripe set. Stripe one is written to disk one, stripe two to disk two, and so forth. RAID 0 sets can include two, three, four or five drives. If the sizes of the disk segments are different, the smallest disk segment will limit the overall size of the RAID Group.
Disk Mirroring (RAID 1)

Disk mirroring creates an identical twin for a selected disk by having the data simultaneously written to two disks. This redundancy provides instantaneous protection from a single disk failure. If a read failure occurs on one drive, the system reads the data from the other drive. RAID 1 sets are typically comprised of two drives, and a third drive can be allocated as a spare in case one of the drives in the set fails. Additional drives can be configured as part of a mirrored set, but without much added benefit. If the sizes of the disk segments are different, the smallest disk segment will limit the overall size of the RAID Group.

Disk Mirroring and Striping (RAID 10)

RAID 10 combines the features of both RAID 0 and RAID 1. Performance is provided through the use of Striping (RAID 0), while adding the fault tolerance of Mirroring (RAID 1). The implementation of RAID 10 requires four drives. The drives are assigned as two sets of mirrored pairs.

Parity RAID (RAID 5)

Parity RAID, or RAID 5, adds fault tolerance to Disk Striping by including parity information with the data. Parity RAID dedicates the equivalent of one disk for storing parity stripes. The data and parity information is arranged on the disk array so that parity is written to different disks. There are at least 3 members to a Parity RAID set. The following example illustrates how the parity is rotated from disk to disk.

Parity RAID uses less capacity for protection and is the preferred method to reduce the cost per megabyte for larger installations. Mirroring requires 100% increase in capacity to protect the data whereas the above example using three hard drives only requires a 50% increase. The additional required capacity decreases as the number of disks in the group increases (i.e., 33% for four drives or 25% for five drives).
In exchange for low overhead necessary to implement protection, Parity RAID degrades performance for all write operations. The parity calculations for Parity RAID may result in write performance that is somewhat slower than the write performance to a single disk.

**Concatenated**

The Concatenated mode combines multiple disks or segments of disks into a single large volume. It does not provide any data protection or performance improvement but can be useful for utilizing leftover space on disks. Concatenation allows the segments that make up the volume to be of different sizes.

![Diagram of Concatenated RAID](image)

**Just a Bunch of Disks (JBOD)**

The JBOD is a virtual disk that can either be an entire disk drive or a segment of a single disk drive. JBOD is the Contiguous configuration option when creating RAID Groups (or sets) in the SATARAID5 Manager utility.

**RAID Volume Status**

A RAID volume can be in any one of the following statuses.

<table>
<thead>
<tr>
<th>Status</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Good</td>
<td>All disks are currently functioning as normal.</td>
</tr>
<tr>
<td>Reduced</td>
<td>For RAID levels that provide data protection, one or more disks have failed but the data is still available via the RAID algorithms. The failed disk should be replaced as soon as possible to avoid loss of data.</td>
</tr>
<tr>
<td>Rebuilding</td>
<td>A failed disk drive has been replaced and the data is being regenerated on the replacement disk. When complete, the RAID Group will return to Good status.</td>
</tr>
<tr>
<td>Resynchronizing</td>
<td>An error has occurred and requires that the RAID algorithms be regenerated on this RAID Group. When complete, the RAID Group will return to Good status.</td>
</tr>
<tr>
<td>Failed</td>
<td>One or more disks have failed and RAID algorithms can no longer regenerate the data. The minimum number of failures required to reach this state depends on the RAID level:</td>
</tr>
<tr>
<td></td>
<td>- RAID 0, Concatenated, JBOD/Contiguous: Single-disk failure.</td>
</tr>
<tr>
<td></td>
<td>- RAID 1, 5, 10: Two-disk failure.</td>
</tr>
</tbody>
</table>
For increased versatility, the SATARAID5 software allows individual disks to be divided into smaller segments that can then be combined into different volumes. As an example, if a user has one set of data that must be protected at all costs, another set of data that should be protected at reasonable cost, and another set that needs no protection at all, the user can divide three disks into segments as shown in Figure 1.

- The yellow segments define the high-security volume.
- The green segments represent the middle-security volume.
- The light blue segments represent the unprotected volume.

**Figure 1 Dividing disks into segments**

Creating a RAID Group

When creating a RAID Group, you can use the available capacity on any hard disk that is connected to your system. You can include disk devices that have never before been used to store data. You can also include disk devices that have previously been designated as Pass-Thru devices if those disks are no longer needed as Pass-Thru devices. However, data that has already been stored on a Pass-Thru device will be overwritten when the hard disk drive becomes a member of a newly created RAID Group. To create a RAID Group, use the following procedure:

1. Select **Create RAID Group** from the RAID Group menu or right-click a controller in the RAID Groups window and select **Create RAID Group** from the pop-up menu.

**Note:** Throughout this manual, the term "right-click" refers to using the secondary button on your mouse to perform the indicated operation. On a Windows or Linux system, use the mouse button that you have defined to be the "right" button (which by default is on the right side of the mouse, unless you have changed the primary and secondary buttons using **Control Panel > Mouse** on Windows). On a Macintosh system, press and hold the COMMAND (Apple) button and click the mouse.
Create RAID Group dialog (for Contiguous, Concatenated and Striped configurations)

Create RAID Group dialog (for Mirrored, Mirrored/Striped and Parity RAID configurations)
2. Enter values in all fields and click **Create** to create the RAID Group.

<table>
<thead>
<tr>
<th>Field</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>RAID Group Label</strong></td>
<td>Enter an identifiable name for the RAID group. This value can be any string (up to 8 characters including blank spaces) to help users identify this volume.</td>
</tr>
<tr>
<td><strong>RAID Group</strong></td>
<td>Select a Group ID from the available ID list. The maximum number of RAID Groups per controller is 8, so Group ID can be any number between 0 and 7, inclusive.</td>
</tr>
<tr>
<td><strong>Configuration</strong></td>
<td>Select which RAID level is to be used to configure these members: • Contiguous (for virtual disk or JBOD). • Concatenated (for multiple concatenated segments). • Striped (for RAID 0) • Mirrored (for RAID 1) • Mirrored Striped (for RAID 10) • Parity RAID (for RAID 5)</td>
</tr>
<tr>
<td><strong>Capacity</strong></td>
<td>Select a value to define the total usable capacity of the RAID Group or manually enter the volume size in gigabytes (GB). Selecting MAX will create the largest RAID set possible with the drive(s) selected.</td>
</tr>
<tr>
<td><strong>Chunk Size</strong></td>
<td>Select a value to define the chunk size (stripe size) for performance tuning. In general, large stripe sizes are best for large files that are accessed sequentially (for example, media streaming files) and smaller sizes are better for randomly accessed data like databases. This parameter is not used for Contiguous (JBOD), Concatenated, and Mirrored configurations.</td>
</tr>
<tr>
<td><strong>Rebuild Priority</strong></td>
<td>Select a value to identify how quickly the controller should rebuild data on a disk after a hardware failure. A value of 1 is the lowest priority and will take the longest to rebuild. A value of 10 is the highest priority and will rebuild the fastest, but may require more CPU resources, which might affect the computer’s performance. This parameter is not used for Contiguous (JBOD), Concatenated, and Striped configurations.</td>
</tr>
<tr>
<td><strong>Check Pointing</strong></td>
<td>Click the radio button to toggle the state of the Check Pointing feature. When Check Pointing is enabled, restoring data is very fast after an unexpected power loss, although normal performance may be slightly reduced. When Check Pointing is disabled, normal performance is improved, but restores can take a long time to complete. This selection is only available when the selected RAID</td>
</tr>
</tbody>
</table>
configuration is Mirrored, Mirrored Striped or Parity RAID, and the “Advanced RAID Features” checkbox in the Configuration/Advanced Options dialog box is checked.

<table>
<thead>
<tr>
<th>Parity</th>
<th>Click the radio button to toggle the state of rebuild ability without taking the volume off-line. This selection is only available when the selected RAID configuration is Parity RAID and the “Advanced RAID Features” checkbox in the Configuration/Advanced Options dialog box is checked.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Devices</td>
<td>Select the RAID member devices from the available device segment grid. Up to five members can be selected for Contiguous, Concatenated, Mirrored, Striped or Parity RAID modes (although Mirrored RAID Groups will typically contain only two members). Exactly four members must be selected for Mirrored Striped mode. Pass-Thru devices will appear with a highlighted background color.</td>
</tr>
</tbody>
</table>

3. If you selected Concatenated in the Configuration field, enter values for individual segment sizes for each disk and click **Create** to create the RAID Group.

4. If you selected Pass-Thru devices as part of the this RAID Group, the following warning appears:

If you want to proceed with creating the RAID Group (which will destroy any existing data that is stored on the Pass-Thru device, select **Yes**. Otherwise, select **No** to return to the Create RAID Group dialog.

5. When you are finished, press **Cancel** to close the Create RAID Group dialog box.
Note: Depending on the manufacturer and capacity of the hard drives that you are using, a small amount of the total disk capacity (less than the amount of one chunk size) may not be available, especially if you have selected one of the larger chunk sizes.

6. Refer to Chapter 4, Allocating Partitions for information about how to define partitions and volumes for the RAID Groups you created.

Additional SATARAID5 Manager Menu Options

This section documents the options available in the SATARAID5 Manager menus.

File Menu Options

Note: All of the SATARAID5 Manager screen illustrations are shown for Microsoft Windows. The frame and buttons may appear slightly different on other operating system platforms. The number of channels shown in this screen will vary according to the type of RAID controller that is installed in your system. The Legacy Support menu item is not available on Macintosh systems.
Configuration

This menu option displays a tabbed dialog box to customize the settings for the Log File location and name, Popup notification messages, and Advanced Options:

- The Log File tab allows you to define the location and name of the log file. The log file is used to store event information received from all Silicon Image RAID drivers. The log file is a text file and can be viewed with any text viewer (such as “Notepad” on Windows platforms) or with the Event Log window of the SATARAID5 Manager.

![Configuration Screen](image)

To specify whether the Log File is generated, click on either the Disabled or Enabled radio button. If Log File generation is enabled, you can click the Browse button to specify the file name and location of the Log File. You can also use the Purge button to delete the contents of the Log File.
The **Popup** tab allows you to define the type of events to trigger notification messages in popup windows. Use the slider control to select an event level. Select:

- Informational to display Informational, Warning, and Error events in a popup window.
- Warning to display Warning and Error events in a popup window.
- Error to display Error events in a popup window.
- Disabled to turn off popup notification messages.
• The **Advanced Options** tab allows you to enable the following advanced features.

<table>
<thead>
<tr>
<th>Feature</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Legacy (Bootable) Support</td>
<td>Enables the Legacy Support menu to support RAID functions for legacy RAID groups (available on Windows and Linux platforms only). See Legacy Support menu options.</td>
</tr>
<tr>
<td>Delete Member Support</td>
<td>Enables the Delete Member option on the Device menu to delete a member from RAID 1 (Mirrored), RAID 5 (Parity RAID), and RAID 10 (Striped and Mirrored) groups. See Delete Member menu option.</td>
</tr>
<tr>
<td>Advanced RAID Features</td>
<td>Enables the selection of an Improper Shutdown Policy (including Check-Pointing and Dirty Parity handling) in the Create RAID Group dialog box when the selected RAID Group type is a fault-tolerant configuration (Mirrored, Mirrored/Striped and Parity RAID). This feature is not supported for Legacy RAID groups.</td>
</tr>
<tr>
<td>Resources Info Support</td>
<td>Enables the Resources option on the Window menu for debugging purposes. See Resources menu option.</td>
</tr>
</tbody>
</table>

**Exit**

This menu option terminates the SATARAID5 Manager GUI.
Device Menu Options

<table>
<thead>
<tr>
<th>File</th>
<th>Device</th>
<th>RAID Group</th>
<th>Window</th>
<th>Legacy Support</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Create Spare</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Delete Spare</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Delete Member</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Delete Orphan</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Make Pass-Thru</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Device Summary</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Create Spare

This menu option displays a dialog box to create a spare disk drive. Enter values for the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Spare Type</td>
<td>Choose one of:</td>
</tr>
<tr>
<td></td>
<td>• Global if the spare drive is for all RAID groups in the system.</td>
</tr>
<tr>
<td></td>
<td>• Dedicated if the spare drive is dedicated to a specified RAID group.</td>
</tr>
<tr>
<td>Capacity</td>
<td>If you selected Global for the Spare Type, select from a list of spare drive sizes. Options include sizes from 128 MB to 100 GB, plus MAX.</td>
</tr>
<tr>
<td>RAID Group</td>
<td>If you selected Dedicated for the Spare Type, select the RAID group to which this spare drive is dedicated.</td>
</tr>
<tr>
<td>Device Segment</td>
<td>Select one device segment from the available device segment grid (Global Spare Type only).</td>
</tr>
</tbody>
</table>

Create Spare dialog (Global Spare Type)

Create Spare dialog (Dedicated Spare Type)
Delete Spare

This menu option displays a dialog box to select (highlight) one or more spare drives to delete. This item is only selectable when one or more spare exists.

Delete Member

This menu option displays a dialog box to select (highlight) RAID group members to delete. Because RAID 0 is not fault tolerant, RAID 0 members are not shown in the list.

Note: Deleting members will demote the RAID group to a non-fault-tolerant RAID group.
Delete Orphan
This menu option displays a dialog box to select (highlight) orphan segments to delete. An orphan segment is part of a RAID group that cannot access other segments within the same RAID group. When a member of a RAID group fails in a severe manner (such as a loss of power or a complete hard disk failure), it becomes an orphan. This item is only selectable when one or more orphan segments exist.

Make Pass-Thru
This menu option displays a dialog box to select (highlight) available reserved devices that you can convert to Pass-Thru mode. Devices allocated to an existing RAID Groups are not included in this list.

Select one or more devices that you want to convert to Pass-Thru devices and then click the Convert button. The following warning appears:
To proceed with the conversion to Pass-Thru mode, click **Yes**. Otherwise, click **No** to return to the Make Pass-Thru dialog.

**Note:** After you create a Pass-Thru device, be sure to delete any partition information that may have been associated with that device.

### Device Summary

This menu option displays the Device Summary window to show all physical devices’ segments.

<table>
<thead>
<tr>
<th>Path ID</th>
<th>Target ID</th>
<th>Status</th>
<th>Capacity</th>
<th>Model</th>
<th>Version</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>0</td>
<td>Healthy</td>
<td>234372952</td>
<td>Maxtor 6Y120M0</td>
<td>YAR51EY0</td>
</tr>
<tr>
<td>0</td>
<td>1</td>
<td>Empty</td>
<td>Unknown</td>
<td>Unknown</td>
<td>Unknown</td>
</tr>
<tr>
<td>0</td>
<td>2</td>
<td>Empty</td>
<td>Unknown</td>
<td>Unknown</td>
<td>Unknown</td>
</tr>
<tr>
<td>0</td>
<td>3</td>
<td>Empty</td>
<td>Unknown</td>
<td>Unknown</td>
<td>Unknown</td>
</tr>
<tr>
<td>0</td>
<td>4</td>
<td>Empty</td>
<td>Unknown</td>
<td>Unknown</td>
<td>Unknown</td>
</tr>
<tr>
<td>1</td>
<td>0</td>
<td>Healthy</td>
<td>320171008</td>
<td>Maxtor 6Y160M0</td>
<td>YAR51HW0</td>
</tr>
<tr>
<td>1</td>
<td>1</td>
<td>Healthy</td>
<td>320171008</td>
<td>Maxtor 6Y160M0</td>
<td>YAR51HW0</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
<td>Empty</td>
<td>Unknown</td>
<td>Unknown</td>
<td>Unknown</td>
</tr>
<tr>
<td>1</td>
<td>3</td>
<td>Empty</td>
<td>Unknown</td>
<td>Unknown</td>
<td>Unknown</td>
</tr>
<tr>
<td>1</td>
<td>4</td>
<td>Empty</td>
<td>Unknown</td>
<td>Unknown</td>
<td>Unknown</td>
</tr>
</tbody>
</table>

The **Capacity** field indicates the number of 512-byte blocks that are available on the device. Items that appear with a highlighted background color are **Pass-Thru** devices.

The Device Summary window has its own menu bar.

- File > Exit closes the Device Summary window.
- Options > Sorting displays a dialog box to sort the rows based on the selected field.

![Sort dialog box]

- Options > Fields displays a dialog box to choose which fields will be shown in the Device Summary window.

![Fields dialog box]

### RAID Group Menu Options

<table>
<thead>
<tr>
<th>File</th>
<th>Device</th>
<th>RAID Group</th>
<th>Window</th>
<th>Legacy Support</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Create RAID Group</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Rebuild RAID Group</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Delete RAID Group</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Bring RAID Group Online</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>RAID Group Summary</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Create RAID Group

This primary menu option is described in [Creating a RAID Group](#).
Rebuild RAID Group

This menu option displays a dialog box to choose a replacement segment to rebuild a reduced RAID group.

Delete RAID Group

This menu option displays a dialog box to select (highlight) RAID groups to delete.

**Note:** After you delete a RAID Group, be sure to delete any partition information that may have been associated with that RAID Group.
RAID Group Summary

This menu option displays a dialog box to show the group ID, label, configuration, and status for all RAID groups.

<table>
<thead>
<tr>
<th>RAID Group</th>
<th>Label</th>
<th>Configuration</th>
<th>Status</th>
<th>Capacity</th>
</tr>
</thead>
<tbody>
<tr>
<td>0</td>
<td>Volume A</td>
<td>Mirrored</td>
<td>Reduced</td>
<td>36.0 GB</td>
</tr>
<tr>
<td>1</td>
<td>Volume B</td>
<td>Striped</td>
<td>Online</td>
<td>36.0 GB</td>
</tr>
</tbody>
</table>

The RAID Group Summary window has its own menu bar.

- File > Exit closes the RAID Group Summary window.
- Options > Sorting displays a dialog box to sort items in the RAID Group list.
• Options > Fields displays a dialog box to choose which fields will be shown in the RAID Group Summary window.
Window Menu Options

This menu option displays the Task Manager window, which lists all RAID and disk management tasks that have been started or finished. You can set the priority any RAID and disk management operations, such as RAID group creation, rebuild, and test.

The Task Manager window has its own menu bar.

- File > Open will be activated in a future release.
- File > Save will be activated in a future release.
- File > Print will be activated in a future release.
- File > Exit closes the Task manager window.
- Options > Sorting displays a dialog box to sort items in the task list.
Options > Fields displays a dialog box to choose which fields will be shown in the task list.

Task > Modify lets you modify parameters of the selected task items. The following is an example of changing rebuild priority for a rebuild task.

Task > Suspend lets you suspend the selected task items.

Task > Resume lets you resume previously suspended task items.
• Task > Cancel lets you cancel the selected tasks, after confirming the cancellation. This option does not permanently delete the tasks.

![](Cancel_Task_Verification.png)

• Task > Delete lets you delete the selected tasks, after confirming the deletion.

![](Delete_Task_Verification.png)

**Event Log**

This menu option displays the Event Log window, which lists SATA device-related events that occur while the SATARAID5 software is running.

![](Event_Log.png)
The Event Log window has its own menu bar.

- File > Exit closes the Event Log window.
- Options > Sorting displays a dialog box to choose up to three fields to sort items in the Event Log window.
- Options > Fields displays a dialog box to choose which fields will be shown in the Event Log window.
Resources
This menu option displays the Resource Information window. This feature is for debugging purpose only.

Legacy Support Menu

On Windows and Linux platforms, you can create and manage Legacy RAID sets and JBOD using the SATARAID5 GUI or the BIOS RAID utility. Previous RAID drivers that do not support RAID 5 functionality are known as “Legacy” drivers and are being replaced with the SATARAID5 software. Legacy RAID volumes are supported by the SATARAID5 software and have the following benefits:

- Legacy volumes can be used as boot devices.
- Legacy volumes can be created and managed by the BIOS menu during system boot.
- Legacy RAID 0 and 10 volumes support a stripe size of 4K.

Note: Legacy Support is not available on Macintosh platforms, and that menu item does not appear.
Create Legacy RAID Group

This menu option is disabled if new RAID groups exist. If enabled, this menu option displays a dialog box to create a legacy RAID group. Enter values for the following parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAID Group</td>
<td>Select a group ID from the available ID list. The maximum number of Legacy RAID Groups is limited to the number of hard drives that are connected to the RAID controller.</td>
</tr>
<tr>
<td>Configuration</td>
<td>Select one of: • Striped (for RAID 0) • Mirrored (for RAID 1) • Mirrored Striped (for RAID 10) • Parity RAID (for RAID 5)</td>
</tr>
<tr>
<td>Capacity</td>
<td>Select from a list of RAID group sizes. Options include sizes from 256 MB to 100 GB, plus MAX.</td>
</tr>
<tr>
<td>Chunk Size</td>
<td>Select a value from the available list to define the chunk size (stripe size) for performance tuning: 8, 16, 32, 64, 128 (KB). Mirrored (RAID 1) does not require a chunk size.</td>
</tr>
<tr>
<td>Rebuild Priority</td>
<td>Select a value to identify how quickly the controller should rebuild data on a disk after a hardware failure. A value of 1 is the lowest priority and will take the longest to rebuild. A value of 10 is the highest priority and will rebuild the fastest, but may require more CPU resources, which might affect the computer’s performance. Striped (RAID 0) does not use this value.</td>
</tr>
<tr>
<td>Devices</td>
<td>Select RAID member devices from the available device segment grid.</td>
</tr>
</tbody>
</table>
Rebuild Legacy RAID Group

This menu option displays a dialog box to choose a replacement segment to rebuild a non-fault tolerant legacy RAID group.

Delete Legacy RAID Group

This menu option displays a dialog box to select (highlight) legacy RAID groups to delete. This option is disabled if no legacy RAID groups exist.

**Note:** After you delete a Legacy RAID Group, be sure to delete any partition information that may have been associated with that Legacy RAID Group.
Convert Legacy RAID Group

This menu option displays a dialog box to select (highlight) legacy RAID groups to convert to new RAID groups of the same RAID type (configuration). This option is disabled if no legacy RAID groups exist.

Create Legacy Spare

This menu option displays a dialog box to create a legacy spare drive. This option is disabled if new RAID groups exist.

Delete Legacy Spare

This menu option displays a dialog box to select (highlight) a legacy spare drive to delete. This option is disabled if no legacy spare drives exist.
Convert Legacy Spare

This menu option displays a dialog box to select (highlight) legacy spare drives to convert to new spare drives. This option is disabled if no legacy spare drives exist.
**Help Menu Options**

- **Help Topics**
  This menu option is not currently available.

- **About**
  This menu option displays information about the SATARAID5 software, including its version, operating system and Java Run-Time Environment version.

![About SATARAID5](image.png)

SATARAID5, Version 1.5.2.0
Copyright 2005 Silicon Image
Running under Windows XP, Version 5.1
Using Java, Version 1.5.0_05 from Sun Microsystems Inc.
Managing Legacy RAID Groups with the BIOS RAID Utility (For Windows Only)

On Windows and Linux platforms with RAID controllers that have two or more ports, you can create and manage legacy RAID sets and JBOD using the BIOS RAID utility or the SATARAID5 GUI. You can create and manage new RAID groups only from the SATARAID5 Manager GUI.

Utility Overview

During the system boot-up process and before the Operating System loads, the following message appears for about 5 seconds. Press CTRL+S or the F4 key to enter the BIOS RAID utility.

```
S11 3132 SATAraID BIOS version 7.1.05
Copyright (C) 1997-2005 SiliconImage, Inc.
Press <Ctrl+S> or F4 to enter RAID utility
0  Maxtor 6Y160M0  152 GB
1  ST380013AS   74 GB

S11 raid1 set  Maxtor 6Y160M0
                 ST380013AS
```

If you are prompted whether to enable large disk support, respond Y so that you can create RAID groups on large disks that the BIOS RAID utility detected.

```
your computer has a disk larger than 512 MB. This version of windows includes improved support for large disks, resulting in more efficient use of disk space on large drives, and allowing disks over 2 GB to be formatted as a single drive.

important: if you enable large disk support and create any new drives on this disk, you will not be able to access the new drive(s) using other operating systems, including some versions of windows 95 and windows nt, as well as earlier versions of windows and ms-dos. in addition, disk utilities that were not designed explicitly for the fat32 file system will not be able to work with this disk. if you need to access this disk with other operating systems or older disk utilities, do not enable large drive support.

do you wish to enable large disk support (Y/N)............? [Y]
```
The RAID Configuration Utility screen is divided into four main sections and a command line.

- **Main Menu**
  - Create RAID Set
  - Delete RAID Set
  - Rebuild RAID Set
  - Resolve Conflicts
  - Low Level Format
  - Logical Drive Info

- **Help**
  - Press “Enter” to create RAID set

- **Physical Drive**
  - 0 Master 6y160mb 152GB
  - 1 ST380013AS 74GB

- **Logical Drive**
  - SIn Raid 1 Set 74GB

- **Command Line**

- The Main Menu section in the upper left lists actions to be performed. Select:
  - Create RAID Group to create a new legacy RAID Set or allocate legacy spare drives.
  - Delete RAID Group to delete a legacy RAID Set or de-allocate a legacy spare drive.
  - Rebuild RAID 1 Set to initiate the rebuild of a RAID 1 set after replacing a drive in the Group.
  - Resolve Conflicts to find the member drives of a disrupted RAID set and restore the Set to proper operation. Do this after moving physical drives.
  - Low Level Format to wipe the data from a single drive. Do not format drives assigned to Sets or allocated as spares.
  - Logical Drive Info to show the current configuration of each RAID set, allocated spare, and unallocated physical drive attached to the SATA host adapter.

- The Help section in the upper right displays context-sensitive help and status messages.

- The Physical Drive section in the lower left displays the model number and capacities of the drives physically attached to the SATA host adapter.

- The Logical Drive section in the lower right displays all logical drives connected to the controller.
  - RAID sets and JBOD drives reported to the system BIOS are listed at the top of this section.
  - Spare drives, reserved drives, conflict drives, and invalid drives not reported to the system BIOS are listed at the bottom of this section.

- The Command Line at the bottom of the screen lists the currently active command keys. Use:
  - Up and Down arrows to select a menu option or action.
  - ESC to go to the previous menu.
  - Enter to select the highlighted choice.
  - Ctrl-E to exit the utility.
  - Other keys may be active depending upon the currently selected action.
Reserved Logical Drives and RAID Set Sizes

When you create a RAID set, spare drive, or JBOD on a physical drive, the BIOS RAID utility saves metadata for the configuration in a reserved area of the physical drive. That metadata is not deleted when a RAID set or drive is deleted. After a set or drive is deleted, the BIOS RAID utility recognizes the physical drive as a reserved logical drive and does not report the drive to the system BIOS.

When creating a RAID set, spare drive, or JBOD, one creation parameter is the size of the set or drive. You can accept the default size or you can use the ↑ and ↓ keys to change the size.

- If the physical drive has not yet been used to create a RAID set or drive, the BIOS RAID utility shows the full size of the physical drive as the default size.
- If the physical drive has previously been used, the utility shows the size that was saved in the reserved area of the physical drive.

When you increase the default size (using the ↑ key), the utility displays a warning message in the Help section of the RAID Configuration Utility screen and waits for you to confirm the size increase before changing the default size.
Creating RAID Groups (Sets)

Select from RAID0, RAID1, and JBOD configurations when creating a new RAID group. Select a RAID level based on factors such as performance, data security, and number of drives available. Consider the long-term role of the system and plan the data storage strategy appropriately.

1. Select Create RAID set from the Main Menu section of the RAID Configuration Utility screen.
2. Select RAID0 (Striped) or RAID1 (Mirrored) and press Enter.

Note: Procedures to create a JBOD configuration or a spare drive for a RAID1 set are documented separately. See Creating a JBOD Configuration and Creating a Spare Drive for a RAID1 Group.
3. Select **Auto configuration** or **Manual configuration** of the RAID Set and press **Enter**.

- If you select **Auto configuration**, the BIOS RAID utility selects RAID member drives automatically and sets the chunk (stripe) size for striped sets to 64KB.
- If you select **Manual configuration**, select the chunk size for Striped Sets or select the Source and Target drives for mirrored sets.

![RAID Configuration Utility](image)

- **Main Menu**
  - **Auto configuration**
    - **Manual configuration**
  
  ![Physical Drive]
  - 0 Maxtor 6Y160M0 152GB
  - 1 ST360013AS 74GB

  ![Logical Drive]
  - Reserved drives

  **Help**
  - Press “Enter” to automatically create raid set
  - Stripe size is 64K
  - First drive is drive 0
4. Select the size of the RAID set with the ↑ and ↓ keys and press Enter.

5. When the Are You Sure? confirmation prompt appears, respond Y to complete the RAID Set configuration.

**Note:** If you have excess capacity left on the hard drives after creating a RAID set in the BIOS RAID utility, you can later go to the SATARAID5 Manager GUI to create additional logical drives that fully utilize the capacity of all hard drives.
Creating a JBOD Configuration

The BIOS RAID utility does not report non-RAID drives to the system BIOS. If a non-RAID boot drive or data drive is desired, create a JBOD so the BIOS RAID utility will report the drive to the system BIOS.

1. Select **Create RAID set** from the Main Menu section of the RAID Configuration Utility screen.
2. Select **JBOD** and press **Enter**.
3. Select **JBOD drive** from the Physical Drive list and press **Enter**.
4. Select the size of the JBOD drive with the ↑ and ↓ keys and press **Enter**.
5. When the **Are You Sure?** confirmation prompt appears, respond **Y** to complete the JBOD configuration.

Creating a Spare Drive for a RAID1 Group

If a RAID 1 set exists, you can create a spare drive for the set. The spare drive can then be allocated to the RAID 1 set if a drive in the RAID 1 set fails.

1. Select **Create RAID set** from the Main Menu section of the RAID Configuration Utility screen.
2. Select **Spare Drive** and press **Enter**.
3. Select a spare drive from the Physical Drive list and press **Enter**.
4. Select the size of the spare drive with the ↑ and ↓ keys and press **Enter**.
5. When the **Are You Sure?** confirmation prompt appears, respond **Y** to complete the spare drive creation.
Additional BIOS RAID Main Menu Options

This section documents additional actions you can perform by selecting menu options in the Main Menu section of the RAID Configuration Utility screen.

Delete RAID Set

Use the Delete RAID set menu option to remove a RAID set, spare drive, or JBOD.

1. Select **Delete RAID set** from the Main Menu section of the RAID Configuration Utility screen.
2. Select the item to delete from the Logical Drive list and press **Enter**.

3. When the **Are You Sure?** confirmation prompt appears, respond **Y** to delete the selected RAID set, spare drive, or JBOD.

The screen then displays a selection of logical drives from which to create a new RAID set.

**Note**: After you delete a RAID Group, be sure to delete any partition information that may have been associated with that RAID Group.
Rebuild RAID1 Set

Rebuilding a RAID1 set copies data from an existing drive to a replacement drive that has been installed in a RAID1 set. Take this action if any member of the RAID1 set fails.

1. Select **Rebuild Raid1 set** from the Main Menu section of the RAID Configuration Utility screen.
2. Select the RAID1 set to rebuild from the Logical Drive list and press **Enter**.

3. When the **Are You Sure?** confirmation prompt appears, respond **Y** to rebuild the RAID1 set. The set is rebuilt. A progress indicator appears in the Main Menu section during the rebuild.
Resolve Conflicts

When a RAID set is created, metadata of drive-connection information, including the channel on the host adapter to which it is connected, is written to the disk. If a newly installed replacement disk was previously part of a RAID set or was used in another system, the replacement disk may have conflicting drive-connection metadata. This prohibits the RAID set from being created or rebuilt.

In order for the RAID set to function properly, use the Resolve Conflicts menu option to write new metadata with the correct drive-connection information to the replacement disk.

1. Select Resolve Conflicts from the Main Menu section of the RAID Configuration Utility screen.
2. Select the Conflict entry in the Logical Drive section and press Enter.

Some conflict resolutions may result in changing the drive letter assignment. For example, the RAID set may have been drive D, and after the conflict resolution, it becomes drive E. To maintain the same drive lettering, the SATA cables connected to the drives may need to be swapped, or in the case of a SATA-based removable drive unit, the order of the drives within the chassis may need to be changed.

3. When the Are You Sure? confirmation prompt appears, respond Y to resolve the conflict. The conflict is resolved and the RAID Set appears in the Logical Drive section.

Low Level Format

The Low Level Format menu option displays a pop-up menu with the following actions:

- Format 1st Partition, which removes the first Silicon Image partition on the disk.
- Secure Format, which formats the entire disk.
- Quick Format, which removes the first Silicon Image partition on the disk plus the last 1GB that contains the Silicon Image meta-data describing partitions.
Note: The Low Level Format actions are typically not required, because formatting the drive under Windows is sufficient to prepare the drive for use.

Logical Drive Info

The Logical Drive Info menu option displays the assignment of physical drives within a logical set (RAID set, RAID 1 spare, or unassigned).

- Use the up and down arrow keys to scroll between the drives in the Logical Drive list.
- Press the ESC key when you are finished viewing logical drive information.
15-4 Allocating Partitions  
(For Windows Only)

After you create RAID groups using the SATARAID5 Manager or BIOS Utility, define partitions on the RAID group and format them for use.

Define a Partition on MS-Windows

Use the Disk Management utility that is part of the XP, 2000, and Windows Server 2003 operating systems to define and format partitions on a Microsoft Windows host computer.

1. From the Start button in the Windows taskbar, select Control Panel > Administrative Tools > Computer Management.

2. Select Disk Management in the Storage section of the utility to display a list of available disks.

![Disk Management Utility](image-url)
The Disk Management utility has three main sections to the right of the navigation tree:

- System listing of all formatted and available disks/RAID Groups (labeled 1 in the image).
- Report of physical connections for disks/RAID Groups (labeled 2 in the image). Every disk should display **Basic**, a **Disk Size** value (available disk space is reported here), and **Online**. Instead of **Basic**, a disk may be marked **Unknown**, **Dynamic**, or **Not Initialized**.

  If a disk is marked **Unknown**, right-click the disk icon and select **Write Signature**. A window opens with the disk in question (all Unknown disks may appear in this window). Make sure the box next to each disk is checked and click OK. The disk should now be marked as a Basic disk.

  If a disk is marked **Dynamic**, right-click the disk icon, and select **Revert to Basic Disk**. Within seconds, the disk should be marked as a Basic disk.

  If a disk is marked **Not Initialized**, right-click the disk icon, and select **Initialize Disk**. An additional dialog box appears allowing you to select which disks to initialize. Uncheck the Config Disk item and click **OK**. Within seconds, the selected disk(s) should be marked as a Basic disk.

- Report of partition status, disk letter, and volume name (labeled 3 in the image). The order in which the drives are listed corresponds to the order the RAID sets appear in the BIOS. The first Unallocated Partition represents Set 1, and so on. In this example, there are two disks with unallocated partitions.

3. Right-click the partition of the first disk to allocate and select **Create Partition** from the pop-up menu.

4. Click **Next** to acknowledge the introductory window to the Create Partition Wizard.

---

**Note:** If an external storage enclosure (such as the SV2000) is connected to the external SATA ports of the RAID controller, one or more additional disk devices may appear with a name of **"Config Disk \(\text{SCSI Disk Device}\)** and a red indicator to show that it is not available. This is normal behavior for Windows, and those disk items should be ignored.
5. Select **Primary partition** and click **Next**.

6. Click **Next** to accept the designated partition size. Because this example is a Striped RAID set with two disk drives, the size of the partition is approximately twice the size of the smallest disk drive.
7. Accept the default drive letter assigned to the partition or select a different drive letter if desired. Click Next.

8. Make sure the **Format this partition with the following settings** radio button is selected. Keep the default of NTFS for the file system and Default for the allocation unit size. Enter a meaningful volume label (name), such as STRIPED SET, FINANCIAL, CRITICAL, and so on. Click Next.
9. Verify the selections are correct and click **Finish**.

The status of the newly created partition changes to **Formatting** and the percentage complete is displayed. Depending upon the size of the partition, the format process may take several minutes. When complete, the status changes to **Healthy** and the name and drive letter are updated. The partitioned disk appears in the System Listing section with all of its pertinent information as well.

10. Repeat this procedure to partition other disks.
11. When you are finished, close the Disk Management utility by clicking the X in the top right corner of the window.
   The new disks are now available for use.

Define a Volume on Mac OS X

After using the SATARAID5 Manager to create one or more RAID Groups, you can use the **Disk Utility** to define and format volumes on a Mac OS X computer system.

1. If you have not previously launched the Disk Utility, click on the **Finder** icon in the task bar, then click on **Applications** from the navigation menu to open the **Applications** folder. In the **Applications** folder, click on **Utilities** to open the Utilities folder. In the **Utilities** folder, click and drag the **Disk Utility** icon to task bar.

2. Click on the **Disk Utility** icon in the Task Bar. The following dialog appears:

   ![Disk Utility Icon](image)

   3. In addition to your system’s hard disk, the RAID Groups that you previously created appear in the list. Click on the RAID Group you wish to format. The following dialog appears:

   ![Disk Utility RAID Groups](image)

   **Note:** Do **not** click on the **Config Drive** item in that list.
4. Click on the “Erase” item along the top menu bar. The following dialog appears:

5. Select the type of Volume Format from the drop-down list in the middle of the page and enter a volume name in place of Untitled (in this example, the name “my volume” is entered). Finally, click on the Erase button. The following confirmation dialog appears:
6. To proceed with the formatting operation, click on the **Erase** button. After the volume is formatted, an icon for the volume will appear on your desktop, and you can begin using that volume.

7. When you are finished creating volumes, close the **Disk Utility**.

**Define a Volume/Partition on Linux**

Reload the SATARAID5 driver to show the newly created SATARAID5 volume. The SATARAID5 driver will show the resulting volume as a block device with prefix “sd”; `/dev/sdx` *(where x is a, b, c, etc.)*. You can then use the **fdisk** command to partition the volume and the **mkfs** command to format the partitions and create a file system on each partition. You can then **mount** the file system as required.

---

**Note:** If an external storage enclosure (such as the SV2000) is connected to the external SATA ports of the RAID controller, one or more additional disk devices may appear with a name of “**Config Disk SCSI Disk Device**”. This is normal behavior, and those disk items should be ignored.
Appendix A Managing the BIOS

When the SATARAID5 driver software is installed on a Windows system, a Control Panel applet is also installed that allows you to update and view information about the RAID controller hardware and its Flash BIOS. You can access the Flash BIOS information using either of the methods described below.

Third-party motherboard and host bus adapter manufacturers provide product-level qualification. Before you upgrade, please verify support for BIOS or driver updates with the product vendor or manufacturer.

**Note:** The information displayed will vary depending on the number and type of RAID controllers that are installed on your system.

## Control Panel Method

To view the Device Information for each of the RAID controllers that are installed in your system, click on Start ➜ Control Panel ➜ Silicon Image ATA Controllers to display the following dialog box:

The upper section of this dialog box lists the RAID controllers that are installed in your system, including the PCI bus slot in which each controller is installed. You can click on each controller in the list to show the detailed device information (if available).

Click on the Flash BIOS tab to display the following dialog box:
This dialog box displays information about the current Flash BIOS and allows you to download an updated Flash BIOS version onto the RAID controller. To download a new Flash BIOS version, enter the filename or click on the Browse… button to navigate to it, and then click on the Program Flash button. The progress bar will show the download status. Do not interrupt the download before it completes.

**Note:** If your RAID controller is embedded on your system’s motherboard, the Flash BIOS tab may not appear. If it does appear, the Flash Chip type, Flash Size, BIOS version and BIOS date will appear as “Unknown”. Any BIOS updates should be obtained from your motherboard vendor.

### Device Manager Method

To view the Device Information for each of the RAID controllers that are installed in your system, click on Start and right-click on My Computer, then select Manage Æ Device Manager and expand the SCSI and RAID Controllers item. Right-click on the RAID controller you want to view, and click on Properties to display the following dialog box:
Click on the **Flash BIOS** tab to display the following dialog box:

![Silicon Image SII 3124 SoftRaid S Controller Properties](image)

This dialog box displays information about the current Flash BIOS and allows you to download an updated Flash BIOS version onto the RAID controller. To download a new Flash BIOS version, enter the filename or click on the **Browse…** button to navigate to it, and then click on the **Program Flash** button. The progress bar will show the download status. Do not interrupt the download before it completes.

**Note:** If your RAID controller is embedded on your system’s motherboard, the **Flash BIOS** tab may not appear. If it does appear, the Flash Chip type, Flash Size, BIOS version and BIOS date will appear as “Unknown”. Any BIOS updates should be obtained from your motherboard vendor.